Volume 42

July, 2010

Command Line
Interface Intro: Part 10
Xfce 4.6.2: Xfce Settings
Manager, Part 2

Xfce 4.6.2: Customize Your Panels
Xfce 4.6.2: Panel PlugIns
Computer
Languages A to Z: Netlogo
How Teenagers View PCLinuxOS
KDE 4: The KDE Netbook Interface

World
Population
Day

Reclaim You Background:
The Widget Dashboard

July 11, 2010

OpenOffice: OpenOffice Writer
Create A Simple PCLinuxOS RPM
How To Set Up A Packaging
Environment in Phoenix 1
And more inside!

Table
Table Of
Of Contents
Contents
3
4
6
7
8
10
14
15
16
17
20
22
23
24
25
30
35
38
42
46
47
48
56
57
58
59
60
63
64
65

Welcome From The Chief Editor
KDE 4: The KDE Netbook Interface
Screenshot Showcase
World Population Day: July 11, 2010
Reclaim Your Background: The Widget Dashboard
Xfce 4.6.2: Xfce Settings Manager, Part 2
Screenshot Showcase
Double Take & Mark's Gimp Tip
ms_meme's Nook: Deep In The Heart Of Linux
OpenOffice: Writer
Xfce 4.6.2: Customize Your Xfce Panels
Screenshot Showcase
How Teenagers View PCLinuxOS
Screenshot Showcase
Xfce 4.6.2: Panel Plugins
Alternate OS: Haiku, Part 1
Game Zone: Osmos
Create A Basic RPM Package For PCLinuxOS
Create A PCLinuxOS Packaging Environment In Phoenix
ms_meme's Nook: That Ol' Linux Call
Forum Foibles: ByteS From The Bunkhouse
Command Line Interface Intro: Part 10
Getting Started With folding@home
Screenshot Showcase
Computer Languages A to Z: Netlogo
Screenshot Showcase
Configuring and Using Epson Stylus NX415
Screenshot Showcase
KarlM: The Loss Of A Friend, Supporter
More Screenshot Showcase

The PCLinuxOS name, logo and colors are the trademark of
Texstar.
The NEW PCLinuxOS Magazine is a monthly online
publication containing PCLinuxOSrelated materials. It is
published primarily for members of the PCLinuxOS
community. The Magazine staff is comprised of volunteers
from the PCLinuxOS community.
Visit us online at http://www.pclosmag.com
This release was made possible by the following volunteers:
Chief Editor: Paul Arnote (parnote)
Assistant Editor: Andrew Strick (Stricktoo)
Consultants: Archie Arevalo, Tim Robinson
Artwork: Sproggy, Timeth
Magazine Layout: Paul Arnote, Meemaw, ms_meme
HTML Layout: Galen Seaman
Staff:
Neal Brooks
Galen Seaman
Patrick Horneker
Guy Taylor
Andrew Huff
Contributors:
Peter Kelly
Daniel MeißWilhelm
Lee Courington

ms_meme
Mark Szorady
Macedonio Fernandez
Meemaw
Gary L. Ratliff, Sr.
Joble
Ryan Smith

The PCLinuxOS Magazine is released under the Creative
Commons AttributionNonCommercialShareAlike 3.0
Unported license. Some rights are reserved.
Copyright © 2010.

2

Welcome
Welcome From
From The
The Chief
Chief Editor
Editor
The July 2010 issue of The NEW PCLinuxOS
Magazine represents a personal milestone for me. It
is the 12th consecutive issue of the PCLinuxOS
Magazine with me as its Chief
Editor. Yep. 12 issues. A full year of
a monthly magazine for the
PCLinuxOS community. And what
was I thinking? Twenty three years
ago, I thought I had left journalism
for good when I left my last job at a
local newspaper (as a photographer)
to start a career in the medical field.
Ha!
Before you get any crazy ideas,
don’t worry. I’m not planning on
going anywhere anytime soon. After
all, we’re only just getting started
here. The magazine’s rebirth in the
last year is only a beginning. We
have lots more to do.
Over the last year, we’ve seen the
magazine reborn as a monthly
publication, instead of the previous
quarterly publication schedule..
We’ve seen the size and content of
the magazine increase. This is
largely responsible to the increased
involvement of the PCLinuxOS community with the
magazine.
We’ve seen the addition of new regular columns in
the magazine: Game Zone, Screenshot Showcase,
Gadgets & Gear, Firefox Addons are examples.
We’ve seen the publication of brilliant, multipart
article series, such as Command Line Interface Intro,

article series that take a closeup look at desktop
environments (so far, KDE 4 and Xfce, with more to
come in future issues on the other desktop
environments), article series
on multimedia formats and
tools, article series on
computer languages, the
Behind The Scenes article
series, and much more.
The last year has seen the
magazine layout evolve and
change to its current state,
allowing us more latitude
and options when laying out
the articles and better
utilizing the available space
on a page, while still
providing an attractive and
easy to read layout.
So, in this issue, we have
critter’s Command Line
Interface Intro: Part 10
article. Athaki reviews KDE
4’s Netbook Interface, and
Stricktoo takes a look at
KDE 4’s Widget
Dashboard.
Leiche walks us through creating a basic RPM file
for PCLinuxOS, while Joble helps get you started
creating a PCLinuxOS packaging environment in
Phoenix. Meemaw and djohnston take a closeup
look at OpenOffice Writer, as part of the
OpenOffice series. djohnston also shows us how to
get started with folding@home.

I continue my look at Xfce 4.6.2, with the second (of
three) installments on the Xfce Settings Manager. I
also walk through how to customize your Xfce
panels, and take a look at the Xfce panel plugins.
I also take a brief look at the 21st annual World
Population Day. The July magazine cover, by
Timeth, commemorates World Population Day.
Xyus makes his magazine debut, with his Game
Zone: Osmos article. It’s the first of what we hope
will be many more such game reviews to come from
him. Lee2010 gives us a look at how teenagers
view PCLinuxOS. Patrick G. Horneker returns with
an article on how to configure the Epson NX415
printer.
Of course, all of your regular columns are back.
georgetoon provides us another installment of
Double Take & Mark’s Quick Gimp Tip. ms_meme
entertains us with two installments of her
ms_meme’s Nook, and features ByteS From The
Bunkhouse in Forum Foibles. And, of course, we
have another collection of PCLinuxOS user’s screen
shots, gleaned from the forum’s monthly
screenshots section, and displayed in Screenshot
Showcase.
I’d like to give the PCLinuxOS community a huge
thank you for all of your support over the last year.
We, the magazine staff, hope you enjoy the
magazine half as much as we enjoy creating it for
you. Stay tuned! There’s lots more yet to come.
So until next month, I wish you all peace, happiness,
contentment and tranquility.
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KDE
KDE 4:
4: The
The KDE
KDE Netbook
Netbook Interface
Interface
by Andrew Huff (athaki)

The preceding screen is what will greet you once the
workspace has been changed. This is called the
'Newspaper' and this is where all of your widgets will
now reside. The default widgets loaded are the
openDesktop widget which is a social
networking/filesharing site for opensource software
users, the KnowledgeBase widget (which is part of
openDesktop), News (which is an RSS feed widget
defaulted to KDE news), and Weather.

The KDE SC Netbook interface has been well
thought out and well implemented (with the
exception of a few caveats; which I've listed at the
end of the article.) In this article, I'll be showing you
how to enable the Netbook UI (user interface) in
PCLinuxOS 2010 and will show off some of its
features.

To launch a program, click 'search and launch'. This
will bring up another screen.

To get started, all you have to do is click on the
'System Settings' button at the bottom of your
taskbar. (It looks like an X made by a wrench and
screwdriver).
In this menu we want to go to the area labeled
'Workspace'. To get to the Netbook UI, all one has to
do is switch the 'Form Factor' to netbook and click
apply.

We'll then need to click on the desktop icon
(highlighted in the picture above). This will bring up
another menu.

From here you have two ways to navigate: clicking
an icon or typing in the name of a program. When
you start to type a name of a program, the computer
will guess the program to which you are referring.
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When you do launch an application, it will open full
screen with no visible toolbar. The toolbar is set to
automatically hide. Just move your mouse to the top
of the screen and it will reappear.

With compositing turned off, you'll get a simple menu
bar underneath the title of the current window.

You also might have noticed a menu option called
'bookmarks'. Initially it is empty, but you can add
bookmarks quite easily to programs you access
often. To do so, just hover your mouse over a
program icon and then click the yellow star in the top
left corner.

The toolbar is also how you are able to close
windows and move between windows. The X at the
top right corner of the toolbar will close your window
and the rectangle next to that will switch the window
between maximized and windowed mode. When you
click on the name or icon of the chosen window, all
of your currently open windows will pop up in a new
screen.
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KDE 4: The KDE Netbook Interface

If you're like me and like to change around the
default wallpaper, the folks at KDE have made it
quite simple; just rightclick on the 'Newspaper'
screen and/or the 'Search and launch' screen and
then click configure.

newspaper activity and will crash the Netbook UI
(sometimes as often as every 15 minutes). When
you change the newspaper activity to a folder view
activity or a desktop activity, you can no longer add
widgets as the add widgets button makes an effort to

load and then fails. The Netbook UI seems to be the
most stable when using the default widgets provided
or not using any widgets at all. This is disappointing;
especially given that the main screen is dedicated to
showing your widgets.

Screenshot
Screenshot Showcase
Showcase

To get out of netbook mode, just repeat the steps
that you made to get into netbook mode; go into
system settings, which is at the top of the search
and launch screen, and then go into desktop, then
workspace, then change it from netbook to desktop
and click apply. You'll be back to your old desktop in
no time.
There are some caveats, however, within the
Netbook UI. Some widgets will not work or will
behave erratically when placed within the

Posted by Ruel24, June 16, 2010, running KDE 4.
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World
World Population
Population Day:
Day: July
July 11,
11, 2010
2010
For additional information on the UNFPA and their
activities, visit their web site at
http://www.unfpa.org/public/pid/1.

by Paul Arnote (parnote)
July 11, 2010 marks the 21st annual World
Population Day, with the theme “Everyone Counts.”
Started in 1989, World Population Day was born out
of the interest generated by the Day of Five Billion
on July 11, 1987. This month’s cover of The NEW
PCLinuxOS Magazine, by Timeth, commemorates
World Population Day.
Sponsored by the United Nations Population Fund,
or UNFPA, it supports countries in using population
data for policies and programmes to reduce poverty
and to ensure that every pregnancy is wanted, every
birth is safe, every young person is free of HIV/AIDS,
and every girl and woman is treated with dignity and
respect. As an international development agency,
they promote the rights of every woman, man and
child to enjoy a life of health and equal opportunity.
In past years, the themes have been “Fight Poverty:
Educate Girls (2009),” “Plan Your Family, Plan Your
Future (2008),” “Men At Work (2007),” “Being Young
Is Tough (2006),” “Equality Empowers (2005),”
“ICPD at 10 (2004),” and “1,000,000,000
Adolescents (2003).”

World Population Day 2010, Everyone Counts, will
underscore the importance of data for development.
It will foster an understanding of why reliable,
disaggregated data is so crucial to progress and
encourage people to participate in the census and
other data collection efforts.
The UNFPA focuses their campaign on several
different fronts. These include:
●
●
●
●
●
●
●
●
●
●
●

Reproductive Health
Population and Development
Data Collection and Use
Gender Equality
Human Rights
Adolescents and Youth
Safe Motherhood
Cultural Sensitivity
HIV/AIDS
Emergencies
HIV and Young People

Additionally, the UNFPA looks at climate change,
and its effects on world population and poverty.

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Reclaim
Reclaim Your
Your Background:
Background: The
The Widget
Widget Dashboard
Dashboard
by Andrew Strick (Stricktoo)
Introduction
Plasmoids are one of my favorite KDE 4 features. I
enjoy being able to see the weather and my system
stats at a glance. It's helpful to have a notepad
perpetually handy. And I especially love the Folder
View plasmoid, because it allows me to keep
multiple sets of files on my desktop while
maintaining some semblance of organization.
Unfortunately this all comes at a price; after a while
there are too many plasmoids and too little desktop.
Fortunately KDE 4 has a solution: the widget
dashboard.
The dashboard can do two things. It can display all
the plasmoids currently on the desktop over all open
windows. That is, instead of minimizing every open
window, you can see your plamoids simply by
bringing up the dashboard. Alternatively, the
dashboard can display a different set of plasmoids.

Personally, I find this application more useful,
because it allows me to use plasmoids while still
maintaining a clean desktop.
Configuring the Dashboard
The settings for the Dashboard are found at:
Configure Your Desktop > Look & Feel > Desktop
> Workspace.

Fig. 03. The Dashboard in overlay mode

Fig 02. The settings dialog

Unfortunately, the dashboard settings are currently
pretty sparse. “Show Desktop Widgets” simply
displays the plasmoids currently on your desktop
(e.g. Fig. 01). “Show an independent Widget Set”
allows the Dashboard to display a different set of
plasmoids than those currently on the desktop (e.g.
Fig. 03).

Fig 01. A very crowded desktop

Moreover, there is no way (that I can find) to change
the shortcut key from Ctrl+F12. However, “Show
Desktop” can be assigned to a screen corner under
Configure Your Desktop > Look & Feel > Desktop
> Screen Edges.
The Dashboard can also have its own background.

While the Dashboard is active, right click and select
“Desktop Activity Settings” or “Folder View Activity
Settings” from the context menu. From there you can
choose a background image like you would for the
regular desktop. However, if you have compositing
turned on, the Dashboard background will be
transparent and will not display an image.

Fig. 04. The Dashboard without a background
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Using the Dashboard
Using the Dashboard is pretty simple. Simply hitting
Ctrl+F12 will bring it up or close it. You can also
close it using the Esc key or by clicking the close
button on the top tab. To add plasmoids to the
Dashboard, (if you are displaying an independent
widget set), right click and chose “Add Widgets” from
the context menu.

Fig. 06. The default System Tray

Quirks
In using the Dashboard, I've stumbled across a
couple oddities. Neither are major, but they can
cause some confusion.

Fig. 05. The Ktorrent "Add Torrent" dialog box under
the Dashboard

Oftentimes initiating the configuration dialog for a
plasmoid causes the dashboard to exit. This doesn't
mean that any changes won't be effective; you'll just
have to bring up the Dashboard (again) to see them.

BONUS TIP

Conversely, bringing up a dialog in another
application does not always cause the Dashboard to
exit. For example, suppose you save a .torrent file to
your Downloads folder. You can add the torrent to
Ktorrent by right clicking on it and choosing “Open
With Ktorrent”. This will bring up Ktorrent's “Add
Torrent” dialog – but it will be under the Dashboard.
However, the dialog will have gained the focus of
keyboard actions, and the Esc key will close the
dialog instead of closing the Dashboard.

1. Unlock your widgets, then right click on a blank
area of the System Tray and select "System Tray
Settings".
2. Choose the "Plasma Widgets" tab (Fig. 07).
3. Place tick marks next to the widgets you would
like displayed in your system tray.
4. Click "Apply".

Conclusion
I hope this short article helps you keep your desktop
clean and clutterfree. Good tinkering

If you want to remove even more widgets from your
desktop, try integrating some into the System Tray.

Fig. 07. The System Tray settings dialog, with the
"Plasma Widgets" tab activated

Fig. 08. The System Tray with widgets

I find this especially useful for my weather, Gmail
Notifier and Device Manager widgets. I don't need
them all of the time. In fact, I only want to see the
Device Manager and Gmail Notifier when I plug in a
device or receive an email. Placing them in the
System Tray, a more natural setting, in my opinion,
makes them accessible while saving precious
screen real estate.
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Xfce
Xfce 4.6.2:
4.6.2: Xfce
Xfce Settings
Settings Manager,
Manager, Part
Part 2
2
by Paul Arnote (parnote)

Under the first tab, Behavior, you can control the
delay and the speed of how a key press behaves
when you hold down a key. You can also set how
fast the cursor blinks. The above screen shot shows
the default values in Phoenix 2010.

In the screen shot above, I've defined the xfce4
screenshooter program to open when I press the
PrtSc (Print Screen) button on the keyboard. I've
also configured xfterm4, the default terminal
program in Xfce, to open when I press the "Access
IBM" button on the keyboard of my IBM Thinkpad
T42 (hence the odd name for the key). You can have
as many application keyboard shortcuts as you like.
But be careful, since having too many could quickly
become problematic, causing you to inadvertently
open programs when you really aren't meaning to.

Previously, we took a look at the first six items in the
Xfce Settings Manager. The Xfce Settings Manager
is what you would use to control how Xfce behaves
on your computer. This month, we take a look at the
next six items, ranging from controlling the keyboard,
to setting up how Xfce manages printing.
Keyboard
The second tab, Application Shortcuts, allows you to
define shortcut keys to automatically launch
applications. By default, there are no shortcuts
defined. Here, in the screen shot above, I've defined
two shortcut keys to launch two separate
applications. You can specify programs to add by
first selecting the "Add" button (lower left of screen
shot), specifying the program to launch, then
specifying the key to use to launch the program by
pressing the key or key combination you want to
use. This makes Xfce highly configurable to how you
work with your computer.

The last Keyboard tab, Layout, allows you to select
the keyboard layouts you want to use. The default is
to use system defaults (checked in the screen shot
above). But if you "uncheck" the option, you can add
multiple keyboard layouts, and switch between them
as needed. Also, if you are from the U.S. and
installed Phoenix 2010, you may have inadvertently
installed the UK keyboard layout (the default in the
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first ISO of Phoenix 2010; the default in the quarterly
remasters is the U.S. keyboard) if you weren't
paying close attention through the installation
process. Never fear, because it's here that you will
need to go to change the keyboard layout to one
more commonly used in the U.S. Simply click on the
"Add" button, and select your keyboard from the list
that appears.

in the screen shot above are the default values in
Phoenix 2010.

Mouse

The Behavior tab allows you to further tune your
pointing device by specifying the drag and drop
threshold, as well as the time and distance
allowances for double clicks of the mouse. The
settings in the screen shot above are the default
settings.

Under the Devices tab of the Mouse settings, you
can select the button order of each of the devices
attached to your computer. In fact, you can make the
settings independently of the other. You can also set
the Acceleration and Threshold for the mouse
pointing device. If you somehow mess things up (or
if someone is trying to prank you), you can reset the
pointing devices to the default values, simply by
selecting the "Reset to Defaults" button. The values

The last tab in the Mouse settings window is the
"Theme" tab. It is here that you set the cursor theme
to use on Xfce. In the screen shot above (next
column), I have changed from the default mouse
cursor theme to the "wonderland" cursor theme. If
you want, you can get additional mouse cursor
themes from xfcelook.org. After downloading, su to
root, and extract the new icon theme to its own
directory in /usr/share/icons. You must log out then
back in after installing the new cursor theme before
it is available for your use.

Panel
The Panel setting
allow you to (you
guessed it) tune
and change the
behavior of your
panels in Xfce.
The separate
window shown in
the screen shot
above opens,
and shows you
the default
settings for the
two panels in a
default
installation of
Phoenix 2010.
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The settings in the default window should be fairly
selfexplanatory to most any user.
If you choose to
make the panel
"freely
moveable," you
are given a
choice of either
horizontal or
vertical
orientation, and
whether you want
a "handle" at
both sides, the
right side only, or
the left side only.
At the top of the
panel window,
you can select
the panel you want to specify the options for. You
can also remove an existing panel by selecting the
red "X" button. Similarly, clicking the green "+" button
allows you to define a new panel for your Xfce
desktop
We'll talk more about panel configuration in a
separate article that focuses just on the panel alone.
Power Manager
Once you install the Xfce power management plug
in from Synaptic, you will get access to the power
settings via the Xfce Settings Manager Power
selection. In the first category, General, you set the

pop up notification windows, for example, should
you be running off of the laptop battery and that
battery starts to get low.
The next category allows us to set the actions Power
Manager uses when the computer is using AC
power, under the Actions tab. (Screen shot bottom of
previous column).

general parameters for the power plug in, as well as
general parameters for what to do in the event that
either the power or sleep buttons are pressed. I
have my plug in set to always show an icon in the
notification tray. I also have it set to "enable
notification." The latter enables the power plug in to
Under the Monitor tab (still under the "On AC"
category), we can set the behavior characteristics for
the Power Manager to apply. The same tab (albeit
with more conservative settings) exists under the
"On Battery" category of settings. The values in the
screen shot above are the default values.
When we select the "On Battery" category, we are
given settings choices that are more relevant to
running a laptop off of a battery. We can specify
what to do when the battery power becomes critical,
what to do when the laptop lid is closed, whether we
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Under the Extended category, we can set more
advanced options. We can select whether the
preferred inactivity "sleep" mode uses Suspend to
RAM or Hibernate (suspend to disk). We can also
set the monitor sleep mode to either Standby or
Suspend. In the third setting, we can specify the low
power warning level when the laptop is running off of
battery. We can also select if we want CPU
frequency control, and if we want to lock the screen
when the laptop is suspending or hibernating
(requires the user to supply a password upon taking
the computer out of suspend or hibernation).

Since I prefer the Google Chromium browser and
prefer using the web interface of Google's Gmail for
my email, I've made changes from the default values
in Phoenix. If your preferred browser or mail reader
is not listed when you open the dropdown selection
box, choose "Other ..." and point to the program you
want to use from the window that opens.

Preferred Applications
want to give precedence to a power saving power
scheme, over performance, and whether to make
the computer to sleep (either standby to RAM or
hibernate, which is set in the next category).

Under the "Utilities" tab, we can select the terminal
emulator program we want to use when we need to
have access to the command line. The screen shot
above reflects the default terminal emulator in
Phoenix 2010, xfterm4, or Xfce Terminal.
The "Preferred Applications" section allows us to set
the preferred programs to use for a few preselected
categories of programs. Under the first tab, Internet,
we can set our preferred web browser and mail
reader. The default values here are Firefox for the
web browser, and Thunderbird for the mail reader.

Printing
The Printing System Selection window is probably
the simplest of all the settings in Xfce Settings
Manager. It simply allows you to tell Xfce how to talk
to your printers, via Xfprint. By default, Phoenix 2010
is set to None. Since I print to a networked printer

13

Xfce 4.6.2: Xfce Settings Manager, Part 2

Screenshot
Screenshot Showcase
Showcase
over my home network, I chose CUPS. You will still
need to complete the setup of your printer in the
PCLinuxOS Control Center (PCC), but you will first
need to complete this setting before you will get the
desired results.
Conclusion & Things To Come
As you are starting to see, between this article and
the one before, Xfce gives you plenty of options in
how to configure your computer. Despite its
lightweight nature, options abound. In the next, and
last part, of the series of articles on the Xfce Settings
Manager, we'll take a look at the rest of the settings
you can make in Xfce.

Your Community Projects Forum

Posted by weirdwolf, June 01, 2010, running PCLXDE.
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Find at least seven differences between cartoons.

Mark's Quick Gimp Tip

After you've used The Gimp for some time,
you'll find yourself creating multiple layers
in order to better edit photos and artwork.
These layers will most likely be created
with a transparent background allowing
you to lay one atop another. This way, you
can see top layers right through to bottom
layers. The Gimp allows you to customize
this bottommost transparent background
so you can better view the art being
edited. Simply go to Edit>Preferences.
Then select Display. On the right, under
Transparency, you'll see a menu where

©2010 Mark Szorady. Distributed by georgetoon.com

by Mark Szorady

Double Take

Double
Double Take
Take &
& Mark's
Mark's Quick
Quick Gimp
Gimp Tip
Tip

you can tweak the
transparent
background. You can
make it checkered,
solid white, gray, or
black. You can also make the checks
of the checkered background large or
small and control their overall tone
(light, medium, or dark). By using the
proper transparent background,
editing an image becomes easier due
to seeing a large contrast between
image and background. This allows
you to better distinguish the art's
edges and other fine details.

Mark Szorady is a nationally syndicated cartoonist. His work is distributed by georgetoon.com. Email Mark at georgetoon@gmail.com.

Answers on Page 34
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ms_meme's
ms_meme's Nook:
Nook: Deep
Deep In
In The
The Heart
Heart Of
Of Linux
Linux
Let's all boot and go meet root
Deep in the heart of Linux
You know of course it's open source
Deep in the heart of Linux
OGG

MP3

X
U
N
I
L
Y
R
T
N
CO U

Say hello to your favorite distro
Deep in the heart of Linux
PCLOS is really the best
Deep in the heart of Linux
Take time to stop at your desktop
Deep in the heart of Linux
Here you can choose widgets to use
Deep in the heart of Linux
Next update and don't be late
Deep in the heart of Linux
It's no chore it's fun galore
Deep in the heart of Linux
Then join your pals both guys and gals
Deep in the heart of Linux
In the forum you'll find some of each kind
Deep in the heart of Linux
Step up to the bar and meet Texstar
Deep in the heart of Linux
Be his friend some cash to him send
Deep in the heart of Linux
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OpenOffice
OpenOffice 2:
2: Writer
Writer
by Meemaw & djohnston
In the overview article last month, I compared
OpenOffice with Microsoft Office, giving you the
matching OpenOffice programs for the popular MS
Office ones. I will add that OpenOffice can be
downloaded and installed for free, rather than having
to fork over your hard earned money every two
years or so for an upgrade. In addition, OpenOffice
will open not only MS Office files, but also files from
Word Perfect and other programs (even the brand
new MS docx files.)
Now that you have configured the basic options for
the whole suite, you may want to get busy with a
word processing document. OpenOffice Writer is,
of course, the one you want to use. When you
open it, there will be a blank 'page' waiting for you
to type. Before you start, however, you may want to
set the margins on your page. In the menu bar,
choose Format > Page. You will see this window,
where you can designate paper size, orientation and

margins. The default is 0.79”. I usually change it to
0.50” or 0.25” depending on what kind of document
I'm creating, whether it's a business letter, or just
saving data for future reference.
Many of the changes you can make to your text can
be accessed from the toolbars as well as the menus.
The toolbars can be configured to include the items
you use most often, so yours may look different from
mine here. If you have tooltips turned on, you can
see what each button is by just hovering the mouse
over it. If you don't use that particular one, remove it
and replace it with whatever you use most.

On my toolbar, I have the following (top row, l to r) 
New, Open, Save, Email, Edit File, Export as PDF,
Print, Print Preview; Spelling & Grammar and Auto
Spellcheck; Cut, Copy & Paste; Format Paintbrush,
Undo and Redo; Hyperlink, Insert Table, Show Draw
Functions (which toggles on or off the OODraw
toolbar on the bottom of the window), Find &
Replace, Navigator, Gallery, Data sources, Zoom
and Help and then (bottom row, l to r)  Apply Style,
Font, Font size; Bold, Italic & Underline; Align Left,
Center, Align Right and Justified; Numbering On/Off,
Bullets On/Off; Decrease Indent and Increase
Indent; Text Color, Highlight Color and Background
Color. The little down arrow at the end of the toolbar,
when clicked, gives you a dropdown where you can
see a list of visible buttons, and a menu item that
allows you to customize that toolbar, lock its
position, or even close it. If you close one by
mistake, you can go to View > Toolbars, and click on
the one you need to open up again. Notice there are

over 20 different toolbars!!! However, most people
use the 'Standard' and the 'Formatting' toolbars in
Writer most of the time, and only pull others up if
they are working on something specialized (tables,
form design, etc) in other OO programs.
One thing that I had to adjust to was the absence of
the 'Page Layout' button that I had on the toolbar in
the other suite. However, it took almost no time at all
to find the menu 'Format' > 'Page' (shown above)
which is the exact same thing.
Another of the buttons on the toolbar is called
'Gallery', which is a
thumbnail collection
of the clipart
available in the suite
(the Gallery button is
on the toolbar in each program because you just
never know when you want to insert a little clipart!)
Your window changes to show the gallery when you
click the button;
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When you first install this office suite you have a
basic set of clipart, but many more can be
downloaded and installed from OO.org
http://extensions.services.openoffice.org/en/taxonom
y/term/169 . (The buildings in the shot above are
one of the extra sets.... another good set is found
here
http://extensions.services.openoffice.org/en/project/o
xygenofficegallery/) When you want to insert one of
the pictures from the gallery, simply click and drag it
from the gallery to your document. In addition, you
can always insert graphics you have stored on your
computer by clicking Insert > Picture > from file and
navigating to your graphic.
You may have noticed that one of the toolbar buttons
is 'Export as PDF'. Open Office does export
documents as Adobe pdf files. This has come in
handy  I never know what type of office program
anyone else has, so instead of saving it as several
different Office docs, just in case someone's version
is really old, I export it as a pdf, and most everyone
can open it. The other upside is that it most likely
won't get altered by someone else if it is in pdf form.
At work I do a newsletter, and the company that
prints it prefers a pdf file, so having it already in that
form when he gets it speeds up the process.
One of the things I like about this suite is that no
matter what you have open, you can go to File >
New or File > Open and open up any other type of
document...like opening a spreadsheet from a text
document window. I never could do that in the other
office suite (but I always thought I should be able
to......)
Earlier in the article I talked about margins and how
the default is 0.79 inches. While that may not bother

you, I always thought it was a pretty strange number
for default, but if your unit of measurement is
centimeters, it makes perfect sense... it's 2 cm. You
can change it, though, to whatever you want. Simply
change the margins and whatever else you want to
what you use most, then save it as a template (File >
Template > Save) with whatever name you want to
give it. (Mine is called WriterTemplate.) It will be
saved to 'My Templates' and then you can go to File
> Templates > Organize, click on your template in
the list, and then when you click on the Commands
button at right, one of the choices is 'Set as Default
Template'. Not too hard.
On the subject of templates, OpenOffice has a few
that are included in your installation, and also many
templates you can download and use. From OO's
main page you can select 'I want to do more with my
OpenOffice' and you will be taken to the template
and extension section of the site. At the top of the
page, click Templates. There are templates for
business letters or invoices, calendars, resumes and
much more. The section includes templates for all
parts of OpenOffice, so if you are looking specifically
for Writer Templates, click Writer in the left margin
and your list will be sorted out to list the templates
for Writer. At the second gallery link above, there are
also links listed for available template sets that can
be added.
Extensions are another thing.
Extensions are addons which
enhance the way that OO
works.You can get different
language dictionaries or even 'Writer's Tools'..... the
site says 'Writer's Tools is a set of utilities designed
to help OpenOffice.org users perform a wide range
of tasks. Using Writer's Tools, you can back up

documents, look up and
translate words and phrases,
manage text snippets, and
keep tabs on document
statistics.' It puts another
menu in your menu bar (see
at right) which has many
useful chores listed.
Galleries are also added to
the extension lists, as are template packages
Something else you can do in your document is
insert a comment. This can be a side note to
yourself that you don't want in the main document,
or, if you are sharing the document with others, it
can be a reference to something else you need to
tell them. Comments can be inserted in the body of
the document. You can insert a comment by placing
your cursor where you want the comment field to be,
then either click Insert > Comment from the topmost
menu, or pressing the key combination Ctrl+Alt+N.
As shown in the help menu,
(The) key combination inserts a comment anchor at
the current cursor position. A comment box is shown
at the page margin, where you can enter the text of
your comment. A line connects anchor and comment
box.

Not shown in the help menu is how to exit the
comments box back to the document page. Pressing
the Esc key will do that.
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Also from the Writer help menu,
Every user with write permission to the document
can edit and delete comments of all authors.

When the cursor is inside the normal text, press the
above mentioned keys to jump to the next or
previous comment anchor. You can also use the
small Navigation window below the vertical scrollbar
to jump from one comment anchor to the next
comment anchor.

The comment box contains an icon with a down
arrow. Click the icon to open a menu with some
commands to delete comments.

You can also open the Navigator to see a list of all
comments. Rightclick a comment name in the
Navigator to edit or delete the comment.

Choose a command to delete the current comment,
or all comments from the same author as the current
comment, or all comments in the document.

Printing comments
To set the printing options for comments in your text
document, choose File  Print, then click Options. To
change the printing option for comments for all your
text documents, choose Tools  Options 
OpenOffice.org
Writer  Print.

Editing comments

If the comment in a text document was written by
another author, there is a Reply command in the
context menu. This command inserts a new
comment adjacent to the comment to which you
want to reply. The comment anchor is the same for
both comments. Type your reply text in the new
comment. Save and send your document to other
authors, then those authors can add replies, too.
Use View  Comments to show or hide all comments
(not available in Calc).
In the Find & Replace dialog of text documents, you
can select to include the comments texts in your
searches.

Zoho > Export to Google Docs and share it with the
person who needs to review it.
When you click on Export to Google Docs, a window
will come up asking for your user name and
password, so the file can be placed in the right
location. It works really well, too.
Hopefully we've gotten you started on whatever you
need to do in Writer. The next article will be an
overview of OpenOffice Calc, the spreadsheet
program.
Enjoy yourself!!!

You can export to
pdf as covered
previously, but what
if you aren't
finished with your
document and want
someone else to
look it over first?
You can File >
Google Docs &

Navigating from comment to comment in text
documents
When the cursor is inside a comment, you can press
Ctrl+Alt+Page Down to jump to the next comment, or
press Ctrl+Alt+Page Up to jump to the previous
comment.
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Xfce 4.6.2:
4.6.2: Customize
Customize Your
Your Xfce
Xfce Panels
Panels
by Paul Arnote (parnote)

me to "redefine" the appearance of the panels on my
netbook.

Just as you are able to do with just about any other
desktop environment, it's also easy to customize the
appearance of the panels on Xfce 4.6.2. By default,
the Xfce has panels at the top and bottom of the
screen, much as you see in the screenshot below:

Probably the easiest way would have been to simply
set either the top or bottom panel to "autohide," or
hide itself unless the mouse cursor hovered at the
respective edge of the screen. But, for my tastes on
my netbook, that still left vital information hidden
from my view that I wanted access to. The
discussion of the panel arrangement that follows is
what's based on my likes, dislikes and the way I
work with my netbook. By all means, let your
imagination run with the possibilities and come up
with an arrangement that works best for you.

Granted, I have added panel plug ins to make my
life easier under Xfce, but the above represents the
default location of the default panels in Xfce.
However, you don't have to live with things as they
come with an "out of the box" Xfce installation. I
installed the Xfce desktop on my netbook to take
advantage of Xfce's lower memory usage and
greater speed, using taskxfce from the PCLinuxOS
repository. And, with the limited screen real estate on
my netbook (8.9 inch screen, with 1024x600 screen
resolution), I didn't feel as if I had room to display
two full panels, full time. So it became necessary for

"Move" from the menu, and clicking and dragging
the item to its new location. In essence, my goal was
to reproduce the main panel in KDE 3.5.10, with
some minor alterations.
In doing this, I left the default bottom panel as it was.
You can easily check that configuration by going to
the Xfce Menu » Xfce Settings Manager » Panel
applet. Here is the default configuration for the
bottom panel in Xfce, which is noted as "Panel 1" in
the following screen shot:

To start with, I decided to completely do away with
my top panel. But before completely deleting it, you
can make your life infinitely easier by simply moving
the panel plug ins that you want to keep to their new
position on the bottom panel. So, with that in mind, I
first moved the Xfce Menu button, the application
launchers, clock, and logout/lock buttons to their
new positions on the bottom panel. This is easily
done by right clicking on the panel plug in, selecting

Next, I had to figure out a place to put additional
launchers that I frequently use. I didn't feel as if I had
enough screen real estate to include them in the
bottom panel, so I created a second panel at the
upper right corner of the screen, like this:
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With the panel set to "Normal Width," it expands as
needed to hold the items you decide to place there.
Finally, I needed to define a place to display my
system notification area, since I didn't want it on the
bottom panel. These are important things, like my
wifi connection, my volume control, my battery
charge indicator, and other things I like to reference
from time to time. So I set up a third panel at the top
center of my netbook's screen, like this:
I set the panel to "autohide." This way, the panel is
out of view and not consuming the valuable screen
real estate when it's not needed. Here is the
configuration for the extra launcher panel, defined in
the following screen shot as "Panel 2," as seen in
the Panel applet window:
you do, do not despair! Here's how to get your Xfce
panels back. It's actually very easy.
Here is the configuration window (top, next column)
for the top center panel, called "Panel 3." It is also
set to "autohide," keeping it out of the way and
preventing it from consuming the screen real estate
until called by moving my mouse cursor to the top
center of the screen.

Step One: Right click on your Xfce desktop.

Troubleshooting

Now, your panels should be back, in their full glory.
For some reason, doing the same from the
command line does not get your panels back, and
only yields error messages.

From time to time, there have been reports of Xfce
users not having any panels at all displayed on the
screen when they boot their computer. Whatever

Step Two: Select "Applications" from the context
menu, then select the "Run Program..." menu entry.
Step Three: Enter "xfce4panel" into the entry box,
and press "Enter."
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Conclusion
As you can see, it's actually quite easy to customize
the location of your Xfce panels. You can further
customize the appearance of your panels by
installing or selecting new Gtk+ 2.0 themes. Your
Xfce panel colors are defined by the Gtk+ 2.0 theme
you select. You can easily change your Gtk+ 2.0
theme by running the Gtk Theme Switch 2 program,
under the Xfce Menu » More Applications »
Configuration. (Note: if you recently upgraded your
Phoenix installation from Xfce 4.6.1 to 4.6.2, you
may need to reinstall the Gtk Theme Switch 2
program from Synaptic. The upgrade appears to
have removed it from the Xfce menu, but it is re
added once you reinstall it from Synaptic.) We won't
be covering creating your own Gtk+ 2.0 themes, as
they are often quite complex. Yet, if you want to find
additional Gtk+ 2.0 themes, head on over to the Xfce
Community's web page and download additional
Gtk+ 2.0 themes. Additionally, there are resources
available on the web on how to make your own Gtk+
2.0 themes, should your interests take you there.

Screenshot
Screenshot Showcase
Showcase

Visit
Visit Us
Us On
On IRC
IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclinuxosmag"
(without the quotes)

Posted by ef2000, June 03, 2010, running e17.
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How
How Teenagers
Teenagers View
View PCLinuxOS
PCLinuxOS
by Lee H. Courington (lee2010)
In high school, I was the “computer guy.” If there was
a problem, I could fix it. I was also known for my use
of something not many people had heard of: Linux.
People were asking me all about it, and I would tell
them it’s free. They would not believe me, so I rolled
my eyes and went about my business. This summer,
as a joke, I asked my close friend if he would install
PCLinuxOS on his laptop. To my surprise, he said
“What do I have to do,” so I told him everything and
he was up and running in under an hour. My
girlfriend saw that, and let me install and set
everything up for her. Again, in less than an
hour, she was a Linux user. Before I had my
current computer, I had an old HP Omnibook
6100 that served me well. But when I
received a newer laptop, my 13 year old
brother got my hand me down laptop. I
reinstalled PCLinuxOS E17 so he would be
happy. Everyone I have mentioned above
views PCLinuxOS in a very different way.
Let's see what each person's views are.
My girlfriend views Linux the same way she
does Windows. To her, it’s just an operating
system. She looked at the desktop after I
installed it, and said “why does your desktop
look so different than mine?” So I had to
explain about how Linux has no rules about
what a “desktop” should be. She liked it, so I
showed her how to customize everything.
She was acting like a kid in a candy store.
It’s all she uses. Maybe she doesn’t add a lot
of crazy apps, but she uses it everyday. The
only time I was told about a problem was

when she texted me saying that her computer was
being “slower than Windows.” So, I called her and
told her how to change it on to performance mode. I
haven’t received one complaint from her since.
My younger brother views Linux as something that is
shiny, and with all the desktop effects, who could
blame him? But he wanted something that worked.
So on a laptop with 512 MB RAM and a 16 MB video
card, what do I do? I put PCLinuxOS LXDE on it! It
runs like a top. When he came to me asking why he
didn’t have cool desktop effects like me, I started to
explain about the video cards and OpenGL, etc. But

Three PCLinuxOS Teens (from left): friend Michael,
girlfriend Dara, and Lee. Not pictured: younger brother Cody.

he didn’t understand any of what I was telling him.
So then I installed taskenlightenment from Synaptic
and he went crazy! He had gadgets on his desktop,
and had crazy cool themes. What more could a 13
year old boy ask for? He views his laptop as
something he can show off to his friends, and brags
about how his brother fixed an old laptop to run
better and faster than all of his friends' new laptops.
My very good friend viewed Linux as something that
only geeks used. So when he let me talk him into
installing it, I was very surprised. But he called me
once he burned the cd, and I talked him through
shrinking his Vista partition so he could install
PCLinuxOS right beside it. He didn’t know you
could boot two different operating systems! So
after the install was over, he didn’t customize it
much. Hey, he spends most of his time online
anyway. His question after installation was
“how do I install Google Chrome?” So, I
launched Synaptic and I installed Chromium.
He was satisfied. I showed him around, told
him about Pidgin and Choqok. His other
passion is games, and after looking through
Synaptic, he asked me where “the good
games” are. So next download was djl, and he
has been smiling ever since.
Lastly I come to myself. I view Linux as pretty
much all of the above. The only difference
between me and them is the fact that I have
been using Linux for many years and I want to
know it from the inside out. I am not afraid of
the command line at all. Sometimes, I actually
like it more. For me, KDE4 is a complete
desktop and I treat it as such. I know what I
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need to install to get my computer to work efficiently.
I view my laptop as something I can use to show
people that there are always alternatives to
Windows and OSX. Linux is a puzzle to me, and it's
missing a piece. I am still learning Linux everyday. I
hope to grow old, log into the forums and be able to
help anyone who needs it.

Screenshot
Screenshot Showcase
Showcase

The fact of the matter is that teenagers view
computers differently than adults. We grew up with
Google, flash games, Microsoft Word, and
computers in general. So that’s what we want: a
computer that works without much of a hassle.
PCLinuxOS does all of that and more. PCLinuxOS
appeals to all types of people, and with all the
different flavors, what can go wrong? If you know
anyone that even shows a hint of interest, point
them in the direction of a Live CD so they can try it
out. Tell them all about the cool things it does. Don’t
go into the "it’s better than OSX and Windows
because...." rant. Just tell them the good things
about PCLinuxOS, and it will all work out in the end.

Posted by Zwopper on June 22, 2010, running KDE4.
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Xfce 4.6.2:
4.6.2: Panel
Panel Plugins
Plugins
by Paul Arnote (parnote)
Despite its reputation and role as a lightweight
desktop environment, Xfce has a good number of
panel plugins to help increase the functionality of
your Xfce desktop – 45 of them, actually. Just as we
did when we took a look at the KDE 4 Widgets, let's
take a look at what all is available with the Xfce
Panel Plugins.
Below is a list of plugins that are available for the
Xfce desktop. All of those listed are in the
PCLinuxOS repository. The plugins that are pre
installed in a default installation of Phoenix 2010 are
highlighted in red. The information following the
plugin comes straight from the definitions that
appear in the "Add New Items" dialog box that
comes up when you go to add a plugin to your
panel.
At the end of the article, we'll also take a closer look
at some select plugins and how to configure them.
But first, let's take a look at the list of available
plugins. The default, preinstalled plugins are
highlighted in red text.
Launcher  Program Launcher with optional menu
Action Buttons  Log out or lock the screen
Battery Monitor  Show and monitor the battery
status
Brightness plugin  Control your LCD brightness
CPU Frequency Monitor  Shows the CPU
Frequency and Governours
CPU Graph  Graphical representation of the CPU
load

Cellualr Moden Monitor  Monitor line quality and
type of cellular modems
Clipman  Clipboard manager
Clock  What time is it?
DateTime  Date and Time plugin with a simple
calendar
Dictionary  A plugin to query different dictionaries
Disk Performance Monitor  Show disk
performance
Eyes  Eyes that spy on you
Free Space Checker  Monitor free disk space
Generic Monitor  Show output of a command
Icon Box  Show icons of all running applications
Keyboard Layouts  Keyboard layouts setup and
switch plugin
Linelight  A simple frontend for the locate search
MPD Client Plugin  A client for MPD, The Music
Player Daemon
Mail Watcher  Check mail from multiple mailboxes
Mixer  Volume control for your sound card
Modem Lights  Simple PPP connections via
modem
Mount Devices  Shows all mountable devices and
(un)mounts them on request.
Notes  Notes plugin for the Xfce4 desktop
Notification Area  Area where notification icons
appear
Orage Clock  What time and date is it?
Places  Access folders, documents, and removable
media
Radio Plugin  V4l radio plugin
Screenshot  Take screenshots of the entire screen,
of the active window or of a region
Separator or Spacing  Adds a space or a line
between panel items
Show Desktop  Hide all windows and show the
desktop

System Load Monitor  Monitor CPU load, swap
usage and memory footprint
Task List  Switch between open windows using
buttons
Time Out  Automatically controlled time outs and
breaks
Trash Applet  Display the trash can
Verve Command Line  Command line interface
with autocompletion and command history
WMdock  Plugin for WindowMaker dockapps
Wavelan  View the status of a wireless network
Weather Update  Show current weather conditions
Window List  Switch between open windows using
a menu
Workspace Switcher  Switch between virtual
desktops
XfApplet  Display Gnome applets in the panel
Xfce Menu  Shows a menu containing categories of
installed applications
Xfce4 Playercontrol Plugin  Audio player control
plugin for Xfce 4.4 panel
Xfce4 Timer  Timer plugin for Xfce 4.4 panel
As you can see, the plugins available for Xfce span
a wide variety of interests.

Installing Plugins
Adding panel plugins is actually quite easy in Xfce.
First, right click your mouse cursor on an empty spot
on the panel you want to add a plugin to. You will get
the following pop up menu.
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the top of the list, because it's the item most people
add most often.

Just click on the launcher icon, and your program
starts right up.

Once you have the item on your panel, you can use
the same pop up menu to move the item to your
desired location, if you don't like the default location.
Just select "Move" from the menu, and drag the
vertical bar to where you want it, and click the
mouse cursor. It's actually pretty simple.

Select the "Add New Items..." menu item, and you
will be presented with the dialog box displayed
below. Just scroll through the (mostly) alphabetized
list to find the plugin that you want to add. I say
"mostly alphabetized," since Launcher appears at

Selecting "Properties" from the pop up menu allows
you to set and customize the options for each of the
plugins. Of course, the options will vary from plugin
to plugin, but this allows you to tailor the plugin to
your needs and to make it behave in a way that
better suits your needs.
Customizing Select Plugins
There are some Xfce plugins that, like everything
else, are more popular with most users. As such,
we'll go over the configuration of some of those
more popular plugins. My apologies up front if your
favorite Xfce plugin is not covered here. But take
solace in the fact that most of the configuration
options are fairly straight forward and easy to figure
out.
Launcher
By far the most popular Xfce plugin, Launcher allows
you to put your most popular and most used
programs only one click away on one of your panels.
No hunting through menus to start your program.

When you select to add a launcher to your panel,
you are greeted with the screen shot above. In the
first space, enter the name for your new launcher.
Under description, whatever you put here will be
displayed in the tool tip when you hover your mouse
over it. Next, click on the black star icon, and you
can choose the icon you want displayed for your
launcher. Next, under the command entry, enter the
command line to launch your program. Oh, what's
that? You're not sure what the command line is?
Click on the disk icon next to the text entry box. A file
selection dialog box will open, already pointing to
your /usr/bin directory. Scroll through the list and find
your program, and click on OK after you've
highlighted your selection with the mouse.
Seems pretty easy, huh? Well it is, but Launcher can
do more. (But wait ... there's more!) Launcher can
also set up a menu of choices when selected. Take a
look at the screen shot below. I'll explain things after
you've had a look.
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the above Launcher window opens, simply select
the item you want to remove, and click on the red
"X" icon. Similarly, you can organize the list of
programs into whatever order you like. Highlight the
item you want to move up or down in the list, and
select either the blue up or down arrows. Click OK to
close the Launcher window, and your changes will
be automatically saved.
Here is what it looks like on your panel:

Now take a look at the list in the far left column.
There are now six different programs listed, in
addition to an icon I chose to use to represent the
category (I chose "that" particular icon because I
have no other use for it). With the "Internet" entry
highlighted in the left pane, the Name field is filled in
simply with Internet. Below that, the Description field
has a longer comment or description that will appear
when a user hovers the mouse cursor over the icon.
Once you have the first item entered, which
essentially becomes the "menu" for the other entries,
you can start adding other programs to the "menu."
By selecting the green "+" icon, you will then get a
blank Launcher screen to fill in. And filling it in is
exactly the same as we did earlier with the single
launcher entry. Repeat this process, selecting the
green "+" icon for each and every Launcher you
want to place in the list.
You can remove anything you wish, at any time, by
right clicking on the toplevel "menu" icon, and
selecting Properties from the pop up menu. When

Xfcescreenshooter
This plugin is not installed by default in Phoenix
2010, but it is available in the PCLinuxOS repository.
In fact, Phoenix 2010 comes with Shutter pre
installed as the default screen capture program. But
sometimes, something else is needed. The Xfce
screenshooter can certainly hold its own when
compared to KDE's KSnapshot, and has been
touted to be even better than Gnome's gnome
screenshot applet. In fact, if you've ever used either
screen capture utility, then Xfcescreenshooter will
feel very, very familiar to you.
Although it is listed in the list of panel plugins, use of
Xfcescreenshooter feels a bit awkward used that
way. Why awkward? Because when you use it as a
panel plugin, you have to go into the Properties of
the plugin to change whether you want it to capture
the entire screen, just the active window, or a region

of the screen. The better (and easier) way to use
Xfcescreenshooter is from a Launcher you place on
your panel. You will not only have more options, but
you will also have all the selections (entire screen,
active window, region of the screen) right at your
fingertips and easier to select on the fly. Plus, the
Xfcescreenshooter will reappear on your screen
after taking and saving the screen shot. When used
as a panel plugin, the program window
disappears/closes every time you take a screen
shot.
With Xfcescreenshooter, you can, as we discussed,
choose to capture the entire screen, just the active
window, or only a region of the screen. You can also
select whether or not to capture the mouse pointer in
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the screen shot. You can set a delay, in seconds,
before Xfcescreenshooter "snaps" the picture. This
is especially handy if you want to capture menus. If
you give yourself between five and 10 seconds, you
will have the chance to open those menus before
the screen shot is captured. Just keep the menu
open until you see the File Save dialog open.
You can choose whether or not to open the save
dialog. You can also select for Xfcescreenshooter to
close automatically after taking the screen shot
capture. You can also choose what action to take on
the resulting screen capture. You can choose to
save it to your computer, and even specify what
directory you want to save it to. You can choose to
merely copy the image to the clipboard, or to open it
with Gimp (or any other graphics program you may
be using). You can also choose to host your screen
capture on ZimageZ, a special graphics host for
Xfce users.

'/usr/bin/xfce4screenshooter' sync
The sync parameter makes calls to X
synchronous.
Battery Monitor

The Battery Monitor plugin allows laptop users to
properly monitor the charge and discharge status
and state of their battery. After adding it to your
panel, right click on the battery monitor icon on the
panel, and select Properties from the pop up menu.
You will then be looking at a window like the one in
the screen shot above.
With it, you can define what Xfce does when you
have a low, then a critical, battery level. If you want,
you can have it run a command that you specify (like
you may want to have your laptop
hibernate/suspend to disk when your battery
reaches the critical level). Feel free to toggle the
various options off and on to configure the Battery
Monitor to a configuration that works for you. The
check boxes are, after all, simply a switch to turn
that particular feature off or on.
Weather Update
There are a lot of desktop environment specific add
ons and plugins available for monitoring the weather.
But that's just it – they are specific to each specific
desktop environment. Gnome has a few, KDE 4 has
a few ... and Xfce has its own, as well. Although this
plugin is not in the default installation of Phoenix
2010, it is available in the PCLinuxOS repository.

Take note of the command line used in the screen
shot of the Launcher for Xfcescreenshooter, above:

Once installed to your panel, you need to open up
the Properties window for the plugin, via the pop up
menu that appears when you right click on the
plugin. You will get a window very similar to the one
in the screen shot below.
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The choices should be fairly obvious in the list.
Choose the item you want displayed, and select the
"Add" button. Repeat this until all the items you want
to display show up in the scrolling list in the lower
half of the window. If you want Weather Update to
animate the transitions between your selected
labels, simply check the box below the list. The
selected labels will appear in the panel, to the right
of an icon that illustrates the current conditions.

you can choose between: Quit, Lock Screen, and
Quit & Lock Screen. I have the one on my lower
panel set to simply lock the screen when I have to
walk away from my computer. Just one quick click,
and my screensaver is activated and my screen (and
computer) is locked.
Conclusion

The first thing you will need to select is if the
information supplied is in Imperial (U.S.) format, or in
Metric format (pretty much everywhere else). If it
hasn't already been preset, you will need to enter
the location you want to monitor. You can search for
your location either by city name, or by postal zip
code.
Next, you set any proxy settings, if applicable.
Finally, you choose which items you want to display.

When you click the left mouse button on the
Weather Update plugin, it will display an extended
five day forecast for the selected location, just like
the one shown in the screen shot above.
Action Buttons
Even though you already have access to this, via the
preinstalled version in Phoenix 2010, I've found it
handy to install a second implementation on my
lower panel. The Action Buttons has three settings

As you can see, Xfce has many panel plugins that
can add additional functionality and convenience to
your Xfce desktop. And it accomplishes this added
functionality and convenience while still staying
within the mindset and goals of Xfce: a functional
desktop environment, without all the bloat. Do
yourself a favor and explore the available Xfce
plugins. You're likely to find one, or two, or a few, or
more that help make your Xfce experience richer
and easier.
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Alternate OS
OS -- Haiku,
Haiku, Part
Part 1
1
by Darrel Johnston (djohnston)
Haiku is a multimedia oriented desktop operating
system. The developers working on Haiku are
working towards a recreation of the Beos 5
operating system. What is BeOS? Quoted from
http://www.student.uib.no/~jri022/huin105/beoshistor
y/whatis.html:
BeOS is the operating system of the future, from the
past!
BeOS is an operating system for personal
computers which began development by Be Inc. in
1991. It was first written to run on BeBox hardware.
Unlike some other operating systems of the time,
BeOS was written to take advantage of modern
hardware. Optimized for digital media work, BeOS
made full use of multiprocessor systems by utilizing
modular I/O bandwidth, pervasive multithreading,
preemptive multitasking and a custom 64bit
journaling file system known as BFS. The BeOS GUI
was developed on the principles of clarity and a
clean, uncluttered design. The API was written in
C++ for ease of programming. It has POSIX
compatibility and access to a command line
interface through the bash shell, although internally
it is not a Unixderived operating system.
BeOS was positioned as a platform which could be
used by a substantial population of desktop users
and a competitor to Microsoft Windows and Linux.
However, it was ultimately unable to achieve a
significant market share and proved commercially
unviable for Be Inc. The company was acquired by
Palm Inc. and today BeOS is mainly used and
developed by a small population of enthusiasts.

In 2001, a group of enthusiasts began building a
BeOS compatible operating system in an open
source manner. Then the name was OpenBeOS,
which changed to Haiku OS in 2004. Today, there's
already fully working VMWare images of a soon
complete operating system which is binary
compatible with the original BeOS.

iso downloaded from here: http://www.haiku
os.org/gethaiku.
I began the installation by setting up the Haiku
virtual machine with the settings you see below.
Then I started the virtual machine.

Quoted from
http://en.wikipedia.org/wiki/Haiku_%28op
erating_system%29:
Haiku began as the OpenBeOS project in
2001, the year that Be, Inc. was bought
by Palm, Inc. and BeOS development
was discontinued; the focus of the project
was to support the BeOS user community
by creating an opensource, backward
compatible replacement for BeOS. The
first project by OpenBeOS was a
communitycreated "stopgap" update for
BeOS 5.0.3 in 2002. In 2003, a nonprofit
organization (Haiku Inc.) was registered
in Rochester, New York, to financially
support development, and in 2004, after a
notification of infringement upon Palm's
trademark on the BeOS name was sent
to OpenBeOS, the project was renamed
as Haiku. However, development would
only reach its first milestone in September
2009 with the release of Haiku R1/Alpha
1. This was followed in May 2010 by
R1/Alpha 2, which contains more than
300 bugfixes and improvements.
So, with all of that in mind, we're going to install the
Haiku R1/Alpha2 version of the operating system in
VirtualBox. We will boot the virtual machine from the

When booting from the CD, you are offered the
option of either running the installer or booting to a
live desktop session. I knew I would need to create a
master boot record and a disk partition in order to be
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able to boot from the
virtual machine's hard
disk, so I chose the
desktop session. A
choice of different
languages and keymaps
can also be selected.
From the desktop, I
doubleclicked the
Installer icon to begin.
The installer warns that
Haiku is "alphaquality
software" and all
important files should be
backed up if installing to
real hardware. A short
tutorial on the GRUB
bootloader is also
included.
The next screen shows
that a suitable partition
needs to be set up before
the installer can proceed.
The first step is to create
an Intel type partition
map for the non
partitioned hard drive.
The hard drive is, in
effect, "blank" at this
point. There is no master
boot record on the drive
defining how the space
on the drive is to be
used. It would be the
same as if you received a

factory hard drive
with no operating
system on it. The
entire disk, known
to Haiku as
/dev/disk/ata/0/ma
ster/raw, will be
written to.
After saving all our
changes, the next
step is to create a
partition.

The default filetype for Haiku is the Be 64bit journal
file system we read about previously. We want to be
able to boot the operating system from the hard
drive, and Haiku will only boot from a Be file system.
The partition must also have the active flag marked
in order to be bootable.
The last step of the partitioning process is to write
the file system type to the newly created partition.
After saving all of the changes, the partition is still
not formatted. It will be formatted as part of the
remaining installation process.
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I clicked the Begin button (not
shown) to start the file transfer
process. It completes fairly
quickly.

Create
partition
map

Create
partition

Drive
setup

Write info to
partition table
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Installing

All steps have completed successfully. The
hard drive installer can be run again and the
operating system installed to another drive or
partition. Looking at the desktop icons, we
have two "hard drives" showing with the same
name, Haiku. The far left icon is actually the
"CD", or the iso file we booted from. The gold
leaf on the front of the drive's icon shows it to
be the boot drive. Once the session is
rebooted without using the iso file, the Haiku
hard drive just set up will become the boot
drive.

finishes. The effect is like KDE's bootsplash screen,
and mimics the original BeOS one.

The bootsplash shows the Haiku logo with an
animated progress meter. The icons
represent each stage of the boot process,
and light up as that part of the process

The user guide is in HTML format on the hard drive.
Double clicking the User Guide icon on the desktop
starts the main page in a browser.

We have booted from the hard drive. Right clicking
on the hard drive icon gives lots of options. There
are a few disk mounting options, and all attached
volumes can be mounted at once by clicking one
button. The username "baron" is the equivalent of
the superuser, or root. In fact, the user baron is the
only user. Haiku, like its predecessor BeOS, is a
singleuser system.
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In the next article, we will take a
closer look at Haiku and what
day to day tasks can be done
with this "operating system of
the future, from the past".

Answers to Mark Szorady's
Double Take:
Three of the windows are of demos available in the
menu. The spinning GL teapot demo is showing a
frame rate of 313.885 frames per second. The Chart
demo is running at 60 frames per second. The
Mandelbrot generator can generate different kinds of
patterns depending on what options are selected.
The Haiku version is shown as R1/alpha2 (Revision
36769) GCC 2 Hybrid. Haiku is an open source
operating system and uses many GNU tools.

(1) Hair longer in back;
(2) Eyes different;
(3) Tooth missing;
(4) Eyeglasses stem
missing;
(5) Shirt stripes different;
(6) yPhone Larger;
(7) “Money” added to
word balloon
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Game Zone:
Zone: Osmos
Osmos
by Ryan Smith (Xyus)

Perhaps the only thing most of us will remember
from our middle school physics classes, Newton’s
third law of motion is apparent in everything on the
macroscale, from the launch of a rocket, to the
friction that keeps you from sliding around when you
walk down the street. This law (as well as
conservation of mass) is also the principle behind
Osmos, a unique commercial ambient puzzle game
where you eject mass and devour other little single
celled organisms to solve a variety of puzzles.
Osmos was developed and published by
Hemisphere Games, a new independent game
company with some interesting credentials. The lead
developers Eddy Boxerman and Dave Burke have
worked as developers on the Splinter Cell
(Boxerman), Gears of War, and Unreal Tournament
franchises (Burke), and Burke also worked as a
developer on the Unreal Engine 3, the engine
behind such blockbusters as BioShock, Gears of
War, and Army of Two. The others that have worked
on Osmos have equally wonderful credentials.
They obviously have the experience to make a great
FPS. But how does that translate into their ambient
physicspuzzle game? Pretty well in my opinion (and
in others [1][2]) despite the fact that it isn’t anything
like the games they are “used to”.

Game Play
Now, back to the subject at hand. The idea of
the game is simple. You are a “mote”, a single
celled organism whose only goal in life is to
become the largest in the pool by absorbing
other motes, or to absorb a specific particularly
delicious looking mote. This is often more difficult
than it sounds, as you must avoid all larger motes,
gravity projecting “Attractor” motes, and the
particularly hostile “Sentient“ motes, while at the
same time competing with them for smaller motes.

will eject mass in the direction that you clicked,
pushing you forward but making you smaller at the
same time. If you touch a mote that is smaller than
you, you will absorb it and gain mass, and if you
touch a mote that is larger, it’ll absorb you (with one
exception  Antimatter Motes will absorb other motes
whether they are smaller or not. Avoid!) Ejected
masses are motes in their own right, able to absorb
or be absorbed by other motes.
In ambient zones, the goal is simple: become the
largest mote. To achieve that goal, you must wade
around in large pool of inactive (Nonsentient)
motes, absorb other motes, and avoid large motes.
While the basic ambient zone level may be simple
and relatively easy, the variants of it can be anything
but. For example, a common variant places you in a
pool full of very fast moving, large motes. Now, not
only do you have to seek out smaller motes while
avoiding larger ones  which is the standard goal,
you also have to do this while they are racing around
at speeds that are possibly faster than yours, not to
mention that the average mote is now larger than
usual.

Levels are categorized into three different types,
or “Zones”  the “Ambient”, “Sentient”, and
“Force” zones  each with different styles of play.
For each zone there is also several variations
with their own challenges. The player may
choose to play a random variation of any level in
the game.
In all zones, you move around the level by
clicking (or holding) the left mouse button in the
opposite direction you wish to move. Your mote
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In sentient zones, your goal is to chase down and
absorb a particularly intelligent mote. This mote will
target other motes, pursue them, and then absorb
them, gaining mass and becoming even more
difficult to absorb. When you get close to a sentient
mote, it will behave differently, depending on what
type of sentient it is. For example, the biophobe will
run in terror as you approach if you are larger but
not bother you while you are small, while more
aggressive types will chase you until you run out of
mass to eject.

will project your orbit onto the screen, helping you
with these levels. Variants include levels with
attractors orbiting other attractors or attractors
repelling each other and bouncing randomly around
the pool (which can be quite chaotic).

Minimum Recommended:
Processor: 1 GHz
Memory: 512 MB RAM
Graphics: 3D graphics card with OpenGL support.
Minimum resolution 800x600
Hard Drive: 33 Mb
Library Requirements:
OpenAL
Freetype
libvorbis and libogg
(Make sure you have the most recent version of
each!)

Availability

In force zones, a two new types of mote are
introduced, the “Attractor”, which projects a gravity
like force around itself that draws other motes
toward it, and the “Repulsor”, which pushes other
motes away with an antigravitylike force. This zone
always has similar goals as the ambient or sentient
zones, but throws in one critical new game dynamic
 players must now factor in orbital dynamics, or risk
being absorbed by the attractor or wasting mass
with bad movements. Don’t worry, pressing “Alt+O”

System Requirements

Osmos is available for Linux, Mac and
Windows (and a version of it exists
for the iPad). The full version
includes 47 levels ranging from
serene to challenging, many different types of
motes, and the ability to play random
variations of any level.

Unfortunately, I couldn’t find hardware
requirements on the official website (or their
forum, or in the readme from the download), so
I took the hardware requirements from the
Steam website (The steam version is for Windows,
so these may not be entirely accurate for Linux. But
it shouldn’t be off by too much).

Osmos is a commercial game, and can be
purchased directly at Hemisphere Games’
Website through PayPal for $10 (US). Direct
purchase includes all three versions, and is
DRM free.
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Hints and Tips
The game play is quite simple, and you’ll pretty
much know exactly what to do in each level.
Anything I could tell you could easily be figured out
while playing the game. That’s not to say I won’t give
you some general tips though, just so you can ‘go in
knowing them’:
* Be careful about how much mass you eject. You
can easily deplete your reserves by holding the left
mouse button down, and it is really easy to use more
than necessary even when you aren’t holding the
button down. While you can get away with this in
early levels, this will haunt you in the later ones.

However, that brings me to my final point: I believe it
is worth $10. Not everyone will. This game is of a
very specific type, and if you have played similar
games before, but didn’t like them, then this game
probably won’t have a different effect on you.
For those of you who are interested, grab the Demo
(middle of the page), and see if it would be
something you’d find fun.

Conclusion/My Thoughts
Osmos is an interesting and fun game. The music is
superb  possibly the best I have heard in the
puzzle/ambient genres  and the dreamlike artwork
adds greatly to the character of the game. I believe
that it is certainly worth the $10, and that it has the
potential to keep you playing once in a while long
after you initially purchase it (anyone who has
played Tetris will know this particular kind of “keep
you playing” feeling).

1.

2.
3.

* After the first couple of levels, you can speed up
the game by clicking the middle mouse button and
slow it down by clicking the right mouse button. Use
this to your advantage.
* While this is not really a game play tip or hint, If
you are finding later levels hard and/or frustrating,
go back to the earlier levels and/or levels in the
Ambient Zone. They are excellent for relaxing. The
music helps.

Disclaimer

4.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.

5.

All the contents of the NEW PCLinuxOS Magazine are only
for general information and/or use. Such contents do not
constitute advice and should not be relied upon in making (or
refraining from making) any decision. Any specific advice or
replies to queries in any part of the magazine is/are the
person opinion of such experts/consultants/persons and are
not subscribed to by the NEW PCLinuxOS Magazine.
The information in the NEW PCLinuxOS Magazine is
provided on an "AS IS" basis, and all warranties, expressed
or implied of any kind, regarding any matter pertaining to any
information, advice or replies are disclaimed and excluded.
The NEW PCLinuxOS Magazine and its associates shall not
be liable, at any time, for damages (including, but not limited
to, without limitation, damages of any kind) arising in contract,
rot or otherwise, from the use of or inability to use the
magazine, or any of its contents, or from any action taken (or
refrained from being taken) as a result of using the magazine
or any such contents or for any failure of performance, error,
omission, interruption, deletion, defect, delay in operation or
transmission, computer virus, communications line failure,
theft or destruction or unauthorized access to, alteration of, or
use of information contained on the magazine.
No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation.
Certain links on the magazine lead to resources located on
servers maintained by third parties over whom the NEW
PCLinuxOS Magazine has no control or connection, business
or otherwise. These sites are external to the NEW
PCLinuxOS Magazine and by visiting these, you are doing so
of your own accord and assume all responsibility and liability
for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The NEW PCLinuxOS Magazine accepts no responsibility for
the content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

37

Create
Create A
A Basic
Basic RPM
RPM Package
Package For
For PCLinuxOS
PCLinuxOS
by Daniel MeißWilhelm (Leiche)

Requires:
Obsoletes:

In the last issues, we created a servicemenu for
KDE4 in PCLinuxOS. We discovered what works
well, and we want share it with other PCLinuxOS
users. But how do we do it?

%description

First, you should read this:
http://www.pclosmag.com/html/Issues/200907/page0
8.html. Neal wrote about creating an RPMPackage.
Following his advice in this article, you will find his
description about the commands within a specfile,
how the commands work, and how the specfile
should be structured.
I keep a blank specfile in my work directory, with
most of the commands that are needed to build a
package.
%define prefix /usr
%define name
%define version
%define release %mkrel 1
%define url
Name:
%{name}
Version:
%{version}
Release:
%{release}
License:
Group:
URL:
%{url}
Source:
Summary:
Summary(de):
BuildRoot:
%{_tmppath}/%{name}buildroot
BuildRequires:

%name < %version

#german
%description l de
%prep

%setup q n %{name}%{version}
%build

cmake . DCMAKE_INSTALL_PREFIX=/usr
%make

%install
rm rf $RPM_BUILD_ROOT
%makeinstall_std

%post
%{update_menus}
%{update_desktop_database}
%postun
%{clean_menus}
%{clean_desktop_database}
%files
%defattr(,root,root)
%{_bindir}/%{name}

%clean
rm rf %{buildroot}
rm rf $RPM_BUILD_DIR/%{name}

%{version}
%changelog
Now we fill in the empty rows. I added the
information for Zip_Player in italics.
• %define prefix /usr – where it should be installed
seamlessly in /usr
• %define name Zip_Player – add the name of the
package
• %define version 0.1 – the actual version of your
program
• %define release %mkrel 3 – needed for rebuild
information by the actual version. Currently, release
0.13 of Zip_Player is in our repositories.
• %define url http://kellerleiche.bplaced.net –
add your homepage or something else, for example:
sourceforge
The header is done, but we can still add more to it.
We have defined the macros, and now we can work
with them.
It's time to get the ingredients for our package.
• Name: %{name} – with the %{name} macros we
set the name of our package
• Version: %{version} – Version has the same
function as Name
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• Release: %{release} – Release has the same
function as Name
• License: GPL – the license our program will have

• #german %description l de Zip Player XMMS
spielt Musik aus Zip Archive. (Erstellt von leiche) –
for the German user, the description for synaptic or
smart package management.

• Group: Sound – the category displayed by the
package manager

Now we have the ingredients, and we can build our
package for PCLinuxOS.

• URL: %{url} – URL has the same function as
Name
• Source: %{name}%{version}.tar.gz – the archive
containing the program
• Summary: Zip_Player plays Your music in zip
archive – summary of the program
• Summary(de): Zip_Player spielt Musik aus Zip
Archive – summary of the program in German
language (you can add other languages, also)
• BuildRoot: %{_tmppath}/%{name}buildroot –
where the package should be built
• Requires: xmms, unzip, zenity, – other packages
needed by the program at runtime
• Obsoletes: %name « %version – will remove the
older version of a package
• %description Zip Player XMMS plays Your music
in ziparchive. (Created by leiche) – a description of
the package

With these commands
%prep
%setup q n %{name}%{version}
the archive will unpack in the BUILD directory.
What is needed for an archive?
We must create a tar.bz2 or tar.gz archive to add our
script and desktop files.
But we need only the scripts that handle our
program.
Why only the script files? The answer comes later.
To create an archive, we generate a folder named
zip_player.0.1. In this folder we put our script files,
then click on the folder with the right mouse button.
In the right click menu you find Compress >>
CompressAsTar. Select that option and the archive
zip_player0.1.tar.gz is created. This must be stored
in SOURCES in our RPM directory.
Now our archive will unpack the BUILD directory to
install in the buildroot directory, which is /tmp
directory.

But our program is still just source code, not
executable code. So we must create the executable
from the sourc with cmake, or configure and make,
before we can install it. Our app doesn't need
configure or cmake, so we can remove the following
lines from our specfile.
%build
cmake . DCMAKE_INSTALL_PREFIX=/usr
%make
In my opinion, we can use direct install.
• rm rf $RPM_BUILD_ROOT – if an older build
exists in the buildroot directory, it will be removed, so
we have no errors when building a new package.
%install
• install d m 755
$RPM_BUILD_ROOT%{_bindir} – the directory
where the compiled package will be installed
(/usr/bin), and what permissions are given to the
installed package
• install m 755 zip_player.sh
zip_player $RPM_BUILD_ROOT%{_bindir} –
what should be installed (zip_player.sh zip_player)
and what permissions are given to the installed
package
Now our scripts are installed, but not the desktop
files. Those can we now generate with our specfile.
• mkdir p
%{buildroot}%{_datadir}/applications –
create the application's folder in /usr/share/. This is
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the path for all desktop files that are placed in the
start menu.
• cat >
%{buildroot}%{_datadir}/applications/%
{name}.desktop << EOF
[Desktop Entry]
Name=Zip Player XMMS
Name[de]=Zip Player XMMS
Comment=plays music in zip archives
Comment[de]=spielt Musik aus den ZIP Archiven
Exec=%{_bindir}/zip_player.sh
Icon=xmms.png
Terminal=false
Type=Application
Categories=Categories=Application;XMandrivaLinux
Multimedia
Sound;AudioVideo;Audio
ServiceTypes=zip
Encoding=UTF8
EOF – cat creates the desktop file
Zip_Player.desktop in /usr/share/applications/.
Between EOF stanzas is where the desktop entry
should be placed.
Now we can add the servicemenu for KDE4 in
/usr/share/kde4/services/ServiceMenus.
• mkdir p
%{buildroot}%{_datadir}/kde4/services/
ServiceMenus – create the folder ServiceMenus in
/usr/share/kde4/services

• %__cat >
%{buildroot}%{_datadir}/kde4/services/
ServiceMenus/%{name}.desktop << EOF

But the specfile is clean, and it updates the menus
and desktop database. Is it needed? I don't know,
but it doesn't seem to do any harm.

[Desktop Entry]
Type=Service
Name=%{name}
Encoding=UTF8
ServiceTypes=application/zip
Actions=zip_player
XKDEServiceTypes=KonqPopupMenu/Plugin
MimeType=zip;ZIP;
Icon=xmms.png

Finally, the files contained in the package are now
defined.
• %files

[Desktop Action zip_player]
Name=Zip Player XMMS
GenericName=Zip_Player
Exec=zip_player
Icon=xmms.png
EOF – cat generates the desktop file zip_player in
/usr/share/kde4/services/ServiceMenus
• %post
%{update_menus}
%{update_desktop_database}
• %postun
%{clean_menus}
%{clean_desktop_database}

Texstar has said that %post and %postun is only
needed if your package is installing library files, say
in /usr/lib, and you need them to be registered or
unregistered with your install.

• %defattr(,root,root) – this function
defines the permissions and properties
• %{_bindir}/zip_player – install the
zip_player in /usr/bin
• %{_bindir}/zip_player.sh – the same as
zip_player
•
%{_datadir}/applications/%{name}.deskt
op – install the desktop file in
/usr/share/applications, which will be displayed in
the start menu
•
%{_datadir}/kde4/services/ServiceMenus
/%{name}.desktop – install the desktop file in
/usr/share/services/ServiceMenus, which will be
displayed in the right click menu
Now the changelog, to see what is changed or
added, and by whom.
• %changelog
* Wed May 26 2010 Texstar <texstar at gmail.com>
0.14pclos2010
 fix rpm/synaptic group Sound
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* Sat May 08 2010 leiche <meisssw01 at aol.com>
0.13pclos2010
 Open Browser filtering *.zip files
 added correct name of Zip Player in Zip Player
XMMS
* Wed Apr 28 2010 leiche <meisssw01 at aol.com>
0.12pclos2010
 shows servicemenu only for zipfiles
 change file open browser from kdialog to zenity
* Thu Mar 04 2010 leiche <meisssw01 at aol.com>
0.11pclos2010
 created for pclinuxos

http://www.pclinuxos.com/forum/index.php/board,55.
0.html.
Last words, I hope it helps somebody to work with
scripts, ServiceMenus, and RPMs under
PCLinuxOS.

If the package compiles without errors, the result is a
package named Zip_Player0.1
4pclos2010.i586.rpm.

Now it's time to generate our package, so we open a
konsole in the directory
/home/daniel/src/rpm/SPECS/, and type the
command:
• rpm ba Zip_player.spec

We did not save our specfile in rpm/SPECS/ , so
create it before you open a konsole, and name the
file Zip_Player.

NOTE:
I'm an absolute rookie at creating an RPM package,
and the tutorial is a little thin on the details. To learn
more about RPM packaging, visit
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Create a PCLinuxOS Package Environment in Phoenix
by Joble
Have you have ever been curious about what it
takes to create packages for PCLinuxOS? The first
and most important step is setting up your
packaging environment. I don’t know if my method is
the best way to do it, but it’s what I did, and it works.
Since I am the maintainer of Phoenix, the
PCLinuxOS Xfce remaster, I’ve chosen to set up my
packaging environment in Phoenix for this article.
To get started, install these packages from Synaptic:
ataskpackagerminimal
pkgutilsthunar

For KDE fans you would need to install task
packagingkde4, which will put context menus in
dolphin for use in Minime.
Next, install any tools or reference materials you
may want to use. I recommend these as a minimum:
filezilla
maximum rpm
(Online at http://www.rpm.org/maxrpm/ or as a PDF,
download this:
http://www.redhat.com/docs/books/maxrpm/max
rpm.pdf)
You will need a PDF viewer for the PDF version. I
recommend epdfview in Synaptic. It’s light, it’s fast,
and it works well. But, there are no window controls
for Xfce, so you have to resize the window by
dragging the edges.

Next, you may want to read through the PCLinuxOS
Packager’s Wiki, at
http://www.pclinuxos.com/wiki/index.php/Category:P
ackaging. The information in the wiki will serve as a
valuable reference as you learn the steps to creating
your own PCLinuxOS packages.
Now, from the command line, run mkrepo help.
This will show you all the options that are available
to set up your own local repository.
[joe@localhost /]$ mkrepo help
Usage: mkrepo [OPTION]...
Create a local repository including
folder structure,
.rpmrc and .rpmmacros files, modify
sources.list, and
optionally install prerequisite build
packages.
Mandatory arguments to long options
are mandatory for short options too.
d, distribution=DIST
Distribution [PCLinuxOS]
s, distsuffix=SUFFIX
Distribution suffix [pclos]
r, release=YYYY
Mandriva
release [2010]
v, vendor=VENDOR
Vendor
p, packager=NAME
Packager
info
b, basedir=DIR
Base
folder for src tree [/home/joe]
a, addpkgs
Install
packages needed to build rpms
n, noupdate
No apt

get update if installing pkgs
u, usage
Display
typical usage and exit
h, help
Display
this help and exit
Use a  as the argument to d,s,r,v,p
to remove an existing macro.
[joe@localhost /]$

mkrepo a d PCLinuxOS v PCLinuxOS s
<your PCLOS user name> p <your PCLOS
user name>
I will not use a, because I've already install atask
packagerminimal and I will change the s to s pclos
as that is what most packagers use. I don’t know
what Tex prefers but I haven’t seen any packager yet
use s username, so I use s pclos.
[joe@localhost /]$ mkrepo d PCLinuxOS
v PCLinuxOS s pclos p Joble
I will be using /home/joe as the base for the source
tree, which is /home/joe/src . These lines will be
written to ~/.rpmmacros:
And the result:
%_topdir
/home/joe/src/rpm
%_tmppath
/home/joe/src/tmp
%packager
Joble
%distribution
PCLinuxOS
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%distsuffix
pclos
%vendor
PCLinuxOS

Continue? [Y/n] Y
Please enter root Password:
Old local repo line(s) found:
Can't find folder
/media/disk/pclinuxos2010/RPMS.main
for Section main in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.updates
for Section updates in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.nonfree
for Section nonfree in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.kde4
for Section kde4 in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.games
for Section games in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS./home/j
oe/src/apt/ for Section
/home/joe/src/apt/ in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.pclinux
os/2010 for Section pclinuxos/2010 in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.athlon
for Section athlon in

"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.i586
for Section i586 in
"/etc/apt/sources.list"
Can't find folder
/media/disk/pclinuxos2010/RPMS.noarch
for Section noarch in
"/etc/apt/sources.list"
Check path "/media/disk/pclinuxos2010"
for folders (or links) like
"RPMS.section"

[joe@localhost /]$ cat
/etc/apt/sources.list
# Package repository URL's

mkrepo is now finished. You can
install source rpms
(*.src.rpm) as normal user by typing:

rpm file:/home/joe/src/apt/
pclinuxos/2010 athlon i586 noarch
(this one was added by the mkrepo command)

File sources.list backed up as
sources.list.old

$ rpm i program.src.rpm
Enjoy building rpms!
[joe@localhost /]$

Now a lot of really neat stuff just happened to your
computer. I won’t explain it here, but if you were to
do all this yourself, it would require a lot of work. For
a more indepth explanation of the process, check
the wiki:
http://www.pclinuxos.com/wiki/index.php/Category:P
ackaging
Notice that the sources.list was backed up to
sources.list.old? If things don't look right in your
sources.list, you might want to restore that.

# Signed repositories have a [<key>]
where <key> is the name of the key
# as it appears in vendors.list. If
you remove it, no digital signature
check
# will be made.
...Snipped a lot of stuff out to shorten this up...

rpm file:/media/disk/pclinuxos/ 2010
main updates nonfree kde4 games

[joe@localhost /]$
Now you need to remove your Thunar configuration
folder:
[joe@localhost .config]$ rm rf
~/.config/Thunar
Once you have completed this, you will need to log
out of Xfce and log back in.
Now that the setup is finished, here’s how to use it!
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Those messages are normal, so do not worry. It just
means Neal built the src.rpm and Neal is not a user
on my computer. I’m not sure why it says using root
when I’m not logged in as root, but it always says
that.

In Thunar, navigate to ~/src/rpm/SPECS and right
click on the spec file.

Now a bit about the packaging environment. The
mkrepo command created the directories needed,
but it helps if you have some idea what they are so
here we go.
In /home/(your user name)/ there is now the
following directories:
First, right click on the *.src.rpm file, and select
“SRPM Install for build” from the context menu in
Thunar.
Below is the output of our previous step. Your output
should look similar.

src

apt  your local repo contains
links to rpm/RPMS
tmp  where the install goes before
getting turned into an rpm.
rpm
BUILD  where the sources are
extracted to during the
build.
RPMS  where the rpm files end
up when you’re finished.
SOURCES  where the source
files go when you
install a src.rpm
SPECS  where the spec files go
when you install a
src.rpm
SRPMS  where the src.rpm will
be after a successful
build

Important: If you are building a package for the
distro you have to put information in the %changlog
section at the bottom of the spec file like so:
* date (hehe, stardate),
YourPCLOSusername, <your email
address>, version and release info
 what you did. First build, update,
added a patch or whatever
* Mon May 24 2010 YourPCLOSUserName
<email at email.com> 0.1.01pclos2010
 first build
Install Dependencies:
The first you want to do after creating or editing a
spec file is to install the dependencies. If you are
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missing one, that is the first error you will get when
you try to build it.
Build All:
Build all will attempt to go through the entire build
process. If all goes well it will report that it has
created an rpm and src.rpm when it is finished.
The rpm file can be found in rpm/RPMS/i586 or
athalon or noarch, depending on the architecture it
was built for.
The rest of the options are incremental steps though
the build process that can help with troubleshooting
when things don’t go so well.
So, how does it work with the local repo? I’ve
actually never run gbd before, so I opened synaptic
and activated only the local repo created by the
mkrepo script. (My other repo is also a local repo,
and I wasn’t sure what might happen to it.) Now
open a terminal and type gbd.
[joe@localhost ~]$ gbd
rm f
/home/joe/src/apt/pclinuxos/2010/base/
*
genbasedir flat bz2only progress
/home/joe/src/apt/pclinuxos/2010
athlon i586 noarch
Components: athlon i586 noarch
Processing pkglists... athlon i586
0002/0002 noarch [done]
Processing srclists... [done]
Updating component releases... athlon
i586 noarch [done]

Creating global release file... [done]
Appending MD5Sum... athlon i586 noarch
[done]
All your base are belong to us!!!

worked on it last. You can find us all, in the
packagers section of the forum.

Update apt package list? [y/N] y
Please enter root Password:
Reading Package Lists... Done
Building Dependency Tree... Done
[joe@localhost ~]$

Now in Synaptic, reload and click the status button
and section New in Repository. If all went well, your
package will be listed there and you can install it. If
it’s not listed there, then go back and make sure
your local repo is checked for use. mkrepo will
activate it by default, and if you forget to run gbd, it
will fail to install.
Personally, I don’t like to bother with the local repo
and gbd. I usually go right to rpm/RPMS/i586 (or
other appropriate directory) and use aptget
install (name of rpm).

Now here’s an interesting little side project for
practice. Wanna know what all those context menus
in Thunar do? Each is linked to a command and can
be executed from a terminal.
http://pclosusers.com/pclosfiles/pclinuxos/2010/SRP
MS.main/pkgutils0.1.44pclos2010.src.rpm
Install that and look at the spec file. Can you find the
command line equivalent to the Thunar context
menus in there? Still wanna be a packager? I know I
do, but I’m glad I’m not trying to edit that spec file.
The changelog shows MBantz, Neal and travisn000
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ms_meme's
ms_meme's Nook:
Nook: That
That Ol'
Ol' Linux
Linux Call
Call

Texstar is a prowlin'
Where the distros are howlin'
Way out where the users bawl
His spurs are a jinglin'
ms_ meme's a singing that Ol' Linux Call

OGG
He works in the shell
He knows darn well
His code will soon enthrall
Bin bash dev home and boot
Yodel odel odel PCLOS

Bin bash dev home and boot
Swap opt don't forget root
Bin bash dev home and boot
Yodel odel odel PCLOS

He has a wide stride
He's know far and wide
By his OS he stands so tall
His friends like to pack they never are slack
'Cause they listen to that Ol' Linux Call

MP3
When his work is done
To the forum he'll come
And post in that ol' Texas drawl
Bin bash dev home and boot
Yodel odel odel PCLOS

46

Forum
Forum Foibles
Foibles
Bytes

from the
Bunkhouse
Rudge: If I am wrong, I am wrong. I learn and thank
the person for pointing it out. I am still, just a dog.
gseaman: Yes, it is good to be able to admit you
are wrong.
coolbreeze: It takes a big person to admit they are
wrong.To admit when your wrong is to gain Respect.
gseaman: Besides, I think it is actually pretty easy
to admit you are wrong. You are wrong! See, that
wasn't so hard.
dubigrasu: Admitting that you are wrong is...hard.
Xyus: I need to apologize for something. Ok. I's
sorry. I's wrong.
longtom: Well  you are wrong. Admit it! Now!
Xero: I admit to being wrong all the time. It heads
off everyone else telling me so.
sammy2fish: Most of the time if you/l are in the
wrong, and say we're not...people know or suspect
different anyways. Then you only loose credibility.

Neal: Wrong? On occasion, yes, I have been.
jaydot: i'm never wrong. i only make mistakes.
grnich: I have heard this about admitting you are
wrong: "If you have to eat crow, it's best to do it while
it's still young and tender"
tuxfriend: If you're never wrong, you can't learn
from your mistakes. So, never being wrong actually
makes you dumber.
coolbreeze: Guess i'll have to make better
mistakes
ElCuervo: My wife says I'm all wrong.
joechimp: It's easy to say your wrong or to say you
are sorry. The integrity lies in saying you were wrong
or saying sorry directly to the person you wronged.
That is something not everyone does. Just my
humble opinion.
blackbird: In the (admittedly implausible) event that
I were to be wrong (at some unlikely time in an
equally unlikely future), I certainly would admit it
before I was found out.
rob0917: One time I thought I made a mistake, but I
was wrong!
djohnston: Read an interesting article the other
day. It was about interviews with Make magazine
contributors. Seems they all agreed they learned
more from their failures than they did their
successes. How does that saying go? Success is
2% inspiration and 98% perspiration.

Xyus: I know I don't learn anything until there is a
huge explosion involved. Most of the time though
not always, those explosions are the result of
failures. Thus, I learn more from failures than
successes.
weirdwolf: Normally if I think I'm wrong I then I'm
usually right about being wrong. It always sucks
when you're wrong and don't know it till much later.
rudge: I always try to avoid committing to being
100% correct unless I know, for sure, 100% that I
am correct. Even then, I sometimes don't push
myself aggressively.
ezas: This reminds me, this weekend I heard this
phrase: First comes rapport, then comes respect. I
liked that.
hounddog: Admit that you're wrong and learn from
your mistake. If you don't admit, you never learn.
Johnboy: That makes it very difficult for those
amongst us who are never wrong ........ seems
being right the whole time makes you dumb, and
being wrong has the opposite effect?
I think there is something wrong with that ........ but
of course I might be wrong ....
newmikey: Oh no, you are totally wrong! Admitting
you are wrong to your wife is one of the dumbest
stupidest things you can do. Believe me, you will
suffer for months afterwards! NEVER admit you are
wrong to your wife. Now go on...admit you were
wrong!
coolbreeze: ONLY months, boy you are one lucky
dude
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Command
Command Line
Line Interface
Interface Intro:
Intro: Part
Part 10
10
by Peter Kelly (critter)
With the release of the Unix operating system in the
early 1970's, there was finally a solid operating
system and a set of tools that had been written to
utilize the advanced features that it supported. The
computing community welcomed it, and some of the
tools raised a lot of interest. One of these was the C
programming language developed by Dennis Ritchie
to enable the system and the tools to be so rapidly
developed. Another one was sed, the stream editor.
Because of the interest generated by sed and some
of the other text manipulation tools, three of the
engineers at Bell Laboratories set about developing
a programming language that would refine and
simplify some of the work done with these tools. It
was released in 1977 under the name awk, which
was derived from the initials of the three developers
Alfred Aho, Peter Weinberg and Brian Kernighan.
Brian had worked with Dennis Ritchie on the C
Language (The basic C language is still known as K
& R C), and a lot of the structure of C found its way
into awk.
Awk was written to enable quick and dirty
commands to be constructed to strip and reformat
lines of text, but by the mid 1980's so much was
being done with this program, much to the surprise
of the authors, that it was revisited to become nawk
(new awk). Much more programming functionality
was added to help it become the scripting utility that
we have today. Linux users will most likely have
gawk, which is similar enough to nawk as to make
no difference to most users.
You may see awk written as 'awk’ and as 'AWK'. It is
generally agreed that awk is the interpreter program

for awk scripts, and AWK is the scripting language
used in those scripts.

AWK

Alfred Aho, one of the developers, described awk
like this:
"AWK is a language for processing files of text. A file is
treated as a sequence of records, and by default each line
is a record. Each line is broken up into a sequence of
fields, so we can think of the first word in a line as the
first field, the second word as the second field, and so on.
An AWK program is a sequence of patternaction
statements. AWK reads the input a line at a time. A line is
scanned for each pattern in the program, and for each
pattern that matches, the associated action is executed."
This pretty much sums up what it does, but doesn't
even begin to do justice to the power and flexibility
of the language  as we shall see.
Using awk need not be a complicated affair. It can
be a simple one line command issued at the
console. awk '{ print $1 }' test would print out the
first word or 'field' on each line of the file test. The
variables $1, $2 ... etc. are assigned to the
corresponding fields in a record. The variable $0
contains the entire input line/record, NF the number
of fields in the current record and NR the number of
the current record.
We should pause here and be clear about with what
it is that we are working.
A 'word', which is also referred to as a 'field', is not
only a language word it is a contiguous group of

characters terminated by white space or a newline.
White space is one or more spaces or tabs, and is
the default field separator. This can be changed to
any arbitrary character by use of the F option
(uppercase) on the command line, or by setting the
variable FS in a script. awk F":" '{print $1}'
/etc/passwd changes the field separator to a colon
and prints out the first field of each line in the file
/etc/passwd which provides us with a list of all
named users on the system.
A record is a group of fields and can be considered
as a card in a card index system. The data on the
card can be details from a directory listing, a set of
values from the result of some test or, as we have
seen, a line from the system /etc/passwd file. The
variable RS contains the record separator, which
by default is set to a newline \n. Changing the value
of RS enables us to work with multiline records
The command line syntax of the awk command is as
follows:
awk {options}{pattern}{commands}
The options for awk are:
F
f
v

to change the field separator
to declare the name of a script to use
to set a variable value.

We could have used v FS=":" to change the field
separator.
There are some others, but as most awk usage is
done in a script, they are little used.

48

Command Line Interface Intro: Part 10

pattern is a regular expression set between a pair of
forward slashes as in sed and is optional. If omitted,
the commands are applied to the entire line.

The #! line must contain the actual address of the
awk executable, which you can check with the
command which awk.

commands are also optional, and if omitted, any
line that matches pattern will be printed out in its
entirety, unchanged.

Actually, if you are running Linux, awk is more than
likely a symbolic link to gawk, the gnu version of awk
which has a few extras, but everything here will work
with either version  unless otherwise stated. If you
want to know which one you are actually using, the
command awk version will tell you.

If both pattern and command are omitted then you
will get a usage reminder, which is no more than you
deserve.
If using awk in a shell script, then its use is more or
less as on the command line.
An awk script is called in one of two ways
1. Create a script file named awkscript or whatever:
{
FS=":"
print $1" uid="$3
}
Call it with the f option: awk f awkscript
/etc/passwd
2. Add a line like this as the first line of the script:
#!/bin/awk f
I prefer to give files like this an 'awkish'
name  uid.awk
Make it executable chmod +x uid.awk
Call it like this: ./uid.awk /etc/passwd

In the script we just created, everything between the
braces is executed once for each line of the input file
or each record. We can also have a 'header' and a
'footer.' These are known as the BEGIN and END
blocks. This is where we put code that we want to
execute just once at the beginning or at the end of
execution. The BEGIN block is where we would
normally initialize variables such as FS, and the
END block can be used to print a final completion
message or summary of completed commands.

All of the sections are optional, although omitting all
three would prove pretty pointless. The following
code prints out the name of all users on the system
who have bash as their default shell.

Note that the slashes need to be escaped. Here, I
have used two equal signs as the equality symbol,
but awk also uses the tilde ~ symbol to match
regular expressions. Normally, we use this as
shorthand for our home directory.

The script then consists of three sections:

But what does it do?

BEGIN{
commands}

Well it processes text and other data.

{

command
|
This is the main part of the script
|
command}
END{
commands}

Yes, sed does that, but if you liken sed to the search
and replace functions in a word processor, then with
awk you can add to that the programming power of a
high level language like C, floating point calculations
including trigonometry and exponentiation, string
manipulation functions, user defined functions, data
retrieval, boolean operators and multidimensional
and associative arrays. Unix/Linux commands often
generate tabulated test output, and awk is the ideal
tool to generate reports from this type of data, easily
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providing a header, selecting and manipulating
selected parts of the data and then providing a final
section to calculate and output a summary.
In short then, awk is a report generator and
advanced scripting language that will do almost
anything, although without some serious hardware
modifications, it will not make your coffee.
With such a complex program as awk, it would be
reasonable to assume that learning to use it was
going to be an uphill struggle, but fortunately this is
not the case. If you have followed along so far
through shell scripting, regular expressions and sed,
then you have already covered most of the hard
work. There are some differences, but nothing that
will hurt your brain.
Simple awk scripts
Although awk can be, and often is, used on the
command line, it becomes most useful when used in
a script. The script can be saved and easily modified
to perform other similar tasks.
Suppose we wanted to know which ext file systems
were listed in /etc/fstab, and where they would be
mounted. We can do this easily with awk using an if
conditional statement. I have used a nested
statement here to ensure that comments are
excluded.

This reads 'If the first field does not begin with a #,
then if the third field contains "ext" followed by one
other character, then print out the file system type
and its mount point.'
This is the output on my machine from the command
./awk1.awk /etc/fstab

start with a hyphen (line 3), and that contain 6 fields
(line 4)
In line 5, we call the built in function sub(), which
substitutes "MegaBytes" for the "M" in the third field.
in line 6, we call another built in function called
split(). This splits up the fourth field, the date field,
using a hyphen as the field separator, and stores
each part as an element of an array named fdate.
Line 7 restricts operation to only those lines where
the third field ends in "BYTES."

awk is often thought of as an alternative to sed, and
it can indeed be used as such. Which one you use
depends upon what you need to do. Remember the
tortuous route we had to go in sed to output the size,
reformatted date and file name from a directory
listing?
sed n e 's/M/ MegaBytes/' e 's/.\{12\}\(.\..
MegaBytes\) \([09]\{4\}\)\([09][09]\)\([09][09]\)
..:.. \(.*$\)/\4\/\3\/\2 \1 \5/p' seddemo
To do this in an awk script we can start by only
considering records (lines) that:

Line 8 prints out the reformatted date, pulling the
elements from the array, followed by the size and file
name fields.
Even though the script contains a lot of material that
you have never seen, I believe it is a lot less
daunting than its sed counterpart, and the output is
identical.
Of course awk can also be called from a shell script,
and indeed many system scripts make extensive use
of awk. There is an important concept to consider
when calling awk from whithin a shell script. In a
shell script, the $ indicates a variable name such as
$USER, whereas in awk, it references a field, such
as $2, which refers to the second field in a record.
When you call awk in a shell, the awk commands
must be single quoted to protect them from shell
expansion. If you passed awk the command '{ print
$USER }' expecting the output to be the users name
as the shells echo command would output, you
would be in for a surprise.
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Awk does not see the variable, but sees a reference
to field number 'USER'. As USER is not defined, it
has a zero value, hence $0, and the entire record is
output.

Each unquoted variable is expanded to its value so
that print $'$owner' becomes print $3 (the third
field). Two $ signs are required, as $owner is seen
as simply 3. The \t in the command is a tab
character.

Integer numeric functions included in awk are quite
complete, and should satisfy the needs of most
people. Floating point operations in awk are fine if
you need them, or as a work around to the shell’s
inability to handle floats, but remember to return the
value to the shell as a text string. I have found little
use for these functions in awk, despite my daily work
requiring a considerable amount of mathematics,
there are always better tools for this, just as you
wouldn't write a letter in a spreadsheet even though
it is possible.
Text manipulation functions are really what awk is all
about, so I'll start with those.
Substitution is a common task, and awk provides
three functions to achieve this:

In this bash script, we pipe the output from a
directory listing of the users home directory into an
awk command, which outputs the owner, group and
file name of each entry.
The first part of the script assigns the values to the
variables, and then echoes them to screen to show
the values that they have in that part of the script.
The directory listing is then piped into the awk
command, which has a BEGIN section to print a
header, the main section has a single print
statement which is applied to all input lines with 8
fields and an END section to end the report.
Syntax highlighting shows how the quoting is turned
on and off to allow or deny shell expansion.

The use of built in functions, as used in the script,
demonstrate some of the power available in awk. So
perhaps we should look at some of the available
functions, what they do and how we call them.
awk's built in functions can be grouped as:
●
●
●

text manipulation functions
numeric functions
file handling functions

File handling functions in awk are best left alone.
Use something more suitable wherever possible. If
you need to control the opening and closing of files,
call the awk command from within a shell script and
let the shell control the files. Shells excel at file
handling.

sub() and gsub(). These are analogous to the s
command in sed and the s command with g(lobal)
option.
gensub() This a general substitution function in
gawk. It is not found in the original awk, so beware if
your code is meant to be portable.
The first two functions are called by sub(/regexp/,
replacement, searchtarget). This is like saying
"substitute( whatevermatchesthis, withthis, in
this)."
The 'inthis' part is where to search for the match,
and can be a variable ($myvar), a reference to a
field ($1) or an element of an array (array[1]). If
omitted, then $0 (the entire record) is searched.
Note that if the searchfield is omitted, then omit the
second comma or you will get an error.
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This enables you to easily replace a particular
occurrence where multiple matches may be possible
within a record.
The gsub() function works identically with the search
target, restricting the 'global' replacement to a
particular part of the record.
The gensub() function is called by
gensub(/regexp/, replacement, how, search
target).
The parameter how is new. If it is g or G, then all
matches are replaced. If it is a number, then only the
match corresponding to that number is replaced.
sub() and gsub() modify the original string as it
passes through, as demonstrated in our first little
script where 'M' was changed to ' MegaBytes'. (The
string or record is modified, not the original file).
gensub() does not alter the original string, but
returns it as the result of the function. Therefore, an
assignment is required to make use of the changes.

This changes the first occurrence of the string "jane"
to "me," and returns the result in the variable
"owner."

As the first occurrence of "jane" is in the third field of
the file listing, we can see that "owner is indeed
"me," but the original third field $3 is unchanged, as
we can see by printing out $0  the original input
record.

Instead of assigning the result of the function to a
variable, it can be assigned directly to the print
command like this:
print gensub(/jane/, "me", "1" ).
split() is another function used in the first example
and is an extremely convenient tool to have around.
Split( string_to_split, name_of_an_array,
separator )
It takes a string, specified as the first parameter,
searches for what is specified as a separator in the
third parameter, and stores each separated 'chunk'
as an element of the array specified as the second
parameter. The separator can be a single character
or a regular expression. If it is omitted from the
command, then the current value of the awk variable
FS is used. If it is the empty string "", then each
individual character is stored in a separate element
of the array. The return value of the function is the
number of elements in the array.
This is great for tasks like dealing with names and
addresses, or for converting a numerical value into
its text equivalent.

In this example we feed a date to the script in a
space separated numeric form and output the date
with a textual month.

The months are preloaded into an array in the
BEGIN section of the script. The second assignment
statement needs to include a separating space at
the beginning, or we would get a month called
'JulAug'. Also, in the second assignment statement
is another feature of awk, concatenation by including
a space between the variable name and the string to
be joined to it.

length() a nice, easy one.
length( string)
It simply returns the length of the supplied string or,
if no string is specified, the length of the current line
$0.
substr()
substr( string, startposition, max_length )
This function returns the substring that begins at
start_position, and extends for max_length
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characters or to the end of the string. If max_length
is omitted, the default is the end of the string.
The function returns the substring found. It is not
used to change a part of a string. Use sub() for that.
These functions can also be used on the command
line, although they a more usually found in scripts.
To demonstrate command line usage, we can send
the output from the uname r command (which
shows the release of the currently used kernel)
through a pipe to awk, and apply the substr()
function to find only a part of the output and print
that part to screen.

When you need to find the position of a substring
within a string awk provides the index() function.
index( string, substring ) The return value is the
start position of the substring, or 0 if it is not found.

A similar function is match().
match( string, regular_expression )
Instead of searching for a simple substring, the
match() function uses the much more powerful
regular expression pattern matching. The return
value is, like index(), the starting position of the
match, but this function also sets the value of two of
awks variables: RSTART & RLENGTH
Here's a file we created right at the beginning of this
course:

They each take a single string as an argument and
return a copy of that string, with all of its characters
converted to the respective case.

What could be easier?
While we are dealing with text, I should mention the
sprintf() function.

If we look for the beginning of the time string in the
second line:

We get this result, only the second line contained a
match.

We find the start of the processor description, and
then use the return value to cut out a substring from
there to the end of the line. In this way, we don't
have to know how many words will be in the
description.

Awk has a pair of functions that automate this
process. They are called, not surprisingly
toupper() and tolower().

Something that we often need to do is to convert the
case of characters or strings from upper case to
lower case, or from lower to upper.

This function works just like the printf() function we
used in bash shell scripting, except that this one
doesn't print out the text. It returns a formatted copy
of the text. This is extremely useful and can be used
to create nicely formatted text files, where the fields
of a record may be of indeterminate size.
You probably noticed that the output from the
owners.sh script we used to demonstrate passing
variables in a shell script was ragged and untidy. If
we use the printf statement, instead of the simpler
print command, we can specify exactly how we want
the report to look.
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use numbers as the index to an element of an array.
Its numerical value has no meaning in awk, only the
fact that it is associated with a particular value is of
interest. This makes arrays in awk particularly
flexible and efficient. In most programming
languages, arrays must be declared as to the type of
values that will be stored, and the maximum number
of elements that will be used. A block of memory is
then allocated for that array, and size and type
cannot be changed. awk, however, doesn't care
about any of that. The indices may be anything that
you wish. The stored values may be any mix of
things that you wish, and you may add as many
elements as you wish.

The formatting rules are the same, and the fields to
be output can be given a fixed width or, in the case
of numerical fields, a predetermined format or
number of decimal places. Leading and trailing zero
suppression is supported, as is padding of shorter
fields with spaces or zeroes, as appropriate.
Actually, all variables in awk are stored as strings,
but variables containing numeric values can be used
in arithmetic functions and calculations.
A nice feature of awk is that arrays are associative.
What this means is that an array is a group of pairs.
An index and a value. The index doesn't have to be
an integer, as in most programming languages. It
can be a string. The index is associated with the
value. The order then is irrelevant, although you can

Associative arrays are particularly useful in look up
tables. If you had a text file named phonetic with
contents like this
a Alpha
b Bravo
c Charlie
:
:
y Yankee
z Zulu
Then we could read it into an associative array and
use the array to convert characters to their phonetic
equivalents.

If you happen to run out of steam with awks built in
functions, or you find yourself repeating code, there
is nothing to stop you writing your own functions.
Functions must be declared before any code that
uses them, pretty obvious really except that they
must be declared before the code block that calls
them. This means that the function code should
usually be written outside of and before the main
loop.
The syntax for a function declaration is function
function_name ( parameters ) {actions}
The keyword function is mandatory.
function_name may be almost anything you like
that is not a reserved word, a variable name or a
pattern of characters that could be wrongly
interpreted by awk. It should also begin with a letter
or underscore character.
parameters are a comma separated list of variables
that get passed to the function by the calling code.
The names of the parameters are used by the
function, and do not have be the same as the name
of the argument being passed. Only the value is
passed to the function. Mostly though, it is less
confusing if the names are kept the same.
Any actions inside the braces are what the function
does with the passed parameters, and if a return
statement is included, then that value will be
returned to the calling code.
If a script called a function name myfunction with
the command result = myfunction( string), then
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return newstring in the function code would return
the value that the variable newstring holds in the
function to the variable result.
If we wanted to make more use of our phonetics
script by passing it any phonetics look up list and an
arbitrary string to translate, we could write a function
to do the translation.

In the main loop, the input data file named phonetics
is read into the codes array.
In the END section the function is called and passed
the string c, which is passed on the command line,
and the codes array.
Here is the output from a sample run.

In the BEGIN section, the data file is read in using a
while loop to repeat the process until we get an
empty line. Each line is stuffed into the array codes.
The string to translate is converted to lowercase at
the start of the main loop, and in the body of the
function, a check is made with a regular expression
to see if the letter is in the range az, in which case it
gets converted. If it is not in that range, then it is
output as is, this takes care of spaces, numbers and
punctuation. The strings to be converted may be
piped in to the script, or can be typed interactively on
the command line as below.

Passing the name of the data file on the command
line is useful if there are several data sets that you
wish to switch between, but if there is only one, we
can get the script to read it in by using awks getline
function.

The function appears before the main loop and has
two parameters passed to it, c is the string to
translate and codes is the array of lowercase letters
and their associated phonetic codes. The string is
split into single characters by using an empty string
as the field separator, and then stored in an array
named letters. The length of the string is required to
limit the loop, which loops round from one to the
number of characters in the string printing the code
that corresponds to the current letter.
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Getting Started
Started With
With folding@home
folding@home
by Darrel Johnston (djohnston)
What exactly is it? It is a scientific research project
conducted by Stanford University. Instead of renting
time on a supercomputer to run computations, they
seek individuals who will volunteer their computer's
idle time to the research project. A good description
of what "folding" is at http://folding.stanford.edu/
"You can help scientists studying these diseases by
simply running a piece of software.
Folding@home is a distributed computing project 
people from throughout the world download and run
software to band together to make one of the largest
supercomputers in the world. Every computer takes the
project closer to our goals. Folding@home uses novel
computational methods coupled to distributed computing,
to simulate problems millions of times more challenging
than previously achieved.
Protein folding is linked to disease, such as Alzheimer's,
ALS, Huntington's, Parkinson's disease, and many
Cancers. Moreover, when proteins do not fold correctly
(i.e. "misfold"), there can be serious consequences,
including many well known diseases, such as Alzheimer's,
Mad Cow (BSE), CJD, ALS, Huntington's, Parkinson's
disease, and many Cancers and cancerrelated
syndromes.
What is protein folding?
Proteins are biology's workhorses  its "nanomachines."
Before proteins can carry out these important functions,
they assemble themselves, or "fold." The process of
protein folding, while critical and fundamental to
virtually all of biology, in many ways remains a mystery."

The link to download the client is at
http://www.stanford.edu/group/pandegroup/folding/re
lease/FAH6.02Linux.tgz
The link is to the 32bit client, since PCLinuxOS
does not yet have a 64bit OS. If your computer has
multiple cores, you can run one client per core. Each
client will have a different machine ID number, in
order the keep the running tasks separate. Each
client will be run from within its own folder. There is
no GUI for running the client. It is run in a terminal,
or as a service. Because I never know what project I
will be doing on any of my computers, I run the
program in a quakelike dropdown terminal, rather
than as a service. The possible choices from our
repositories are guake, tilda, and yakuake. The
screenshot below is of a client running in one pane
of the guake terminal.

"The passkey, a new feature beginning with the v6.0 FAH
client, is a unique identifier that ties your contributions
directly to you (not just those with your username). The
use of a passkey prevents others from cheating using your
name. Obtain a passkey from our web site (see below),
enter it when you configure the client, and the client and
servers will do the rest. You should keep your passkey
secret."
To get your passkey, go to
http://fahweb.stanford.edu/cgibin/getpasskey.py
After configuring the client, start it with ./fah6

After downloading the client, open any terminal and
do the following: (note: I am using fold1 as an
example folder name.)
cd fold1
./fah6 configonly
This will start the client's configuration runtime
options. You can override the configuration at any
time by starting folding with a command line option.
For example,
./fah6 advmethods
One of the configuration options is adding a
personal passkey. What is a passkey? From
http://folding.stanford.edu/English/FAQpasskey
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All my clients run 24/7 on desktop machines. The
program is so unobtrusive I barely notice it unless I
bring the dropdown terminal into focus, run top or
htop, or glance at the Gkrellm panel on my desktop.
Cruising the web, viewing videos, opening or editing
OpenOffice documents is just about as quick with
the folding clients running as it would be without
them running. The only other time I notice the
running clients is if I am downloading something
from the web at the same time that a client finishes a
work unit. The client will upload the finished results
to a Stanford University server with a higher priority
than any download process.

Screenshot
Screenshot Showcase
Showcase

Will you join the PCLinuxOS folding team today?

Posted by BubbaBlues, June 19, 2010, running KDE 4.
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Computer Languages
Languages A
A to
to Z:
Z: Netlogo
Netlogo
by Gary L. Ratliff, Sr. (eronstuc)

following area (below):

In this article, we are ready for
some fun. At the half time break,
I mentioned that the system has
KTurtle, which uses logo and a
turtle to draw various lines on a
canvas. Now imagine that the
number of turtles and the number
of canvases was allowed to
increase. And that these turtles
and canvases were allowed to be
interconnected into a model of
some real world behavior. Then
you would have a hint at what
Netlogo has to offer.
Netlogo was authored in 1999 by
Uri Wilensky. It has been
developed and used since that
time at the Center for Connected
Learning and ComputerBased Modeling of
Northwestern University. It is available as freeware
from the netlogo website
(ccl.northwestern.edu/netlogo). The most recent
version was released on Dec. 20, 2009. It is
available for Windows, the Mac, and other operating
systems. The Windows version is 62 megs, the app
for the Mac is 42 megs, and the one which can be
used in Linux is only 41 megs in length. Just click
the download link and fill in a simple form, which
asks for your name and email address. You want the
file: netlogo4.1.tar.gz. This download will take just a
few minutes, and will be placed in your home folder.
It is a very simple matter to unpack it with the
command: tar zxf netlogo4.1.tar.gz. Once this has
been done, change into the directory, which it will
create, using: cd netlogo4.1. This will yield the

using the terminal and
giving the command:
./netlogo.sh. Once
inside the netlogo
system, click on the
Help menu and select
the User manual,
which will produce the
following:    >
As you can see, this
provides a set of
tutorials for learning
the basics of the
system. It is
suggested that you
begin exploring the

Your next
move should
be to read
the
readme.txt
file, which
will show
you how to
use the
application.
However,
you can also
launch this
from within
the netlogo
directory,

system by running the Model Party. In my last article,
I mentioned that it was written about Christmas time
and that there was a movie called “Christmas in
July” playing at that time. It is only appropriate that
we have New Years in August, so this is a model of
a cocktail party which many of you may have
attended around New Years Eve. The model shows
what happens to the tolerance level of people to
form various groups changes.
This model introduces the concept of using the
sliders and the buttons to setup the model. The
model also produces graphs of the changes of the
people throughout the life of the model.
The "setup button" is used to set the initial
conditions. Here, the tolerance level means the
percentage of
people who are
comfortable if the
level of members
of the opposite sex
in their group rises
above a certain
level. The "go
once" button
shows which
groups change at
each step, and the
"go" button runs
these steps until a
conclusion is
reached.
There are very
many models to
use, and they are
setup and run in a
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similar
manner. Just
follow the
tutorials in
order to
advance in
learning
more and
more about
the system,
until you
learn how to
construct
your own
models.

Screenshot
Screenshot Showcase
Showcase

The main
menu item,
Information,
shows
various facts about the model and its uses. And the
Procedures item shows the code for the model. The
models are used in education, and as mentioned on
the initial page of the user manual, Yahoo! has two
groups devoted to this system. One group is
specifically for teachers:
(http://groups.yahoo.com/group/netlogousers)
(http://groups.yahoo.com/group/netlogoeducators)
Meanwhile, the system should provide many hours
to explore the provided models. And the tutorials
should have you ready to create your own models in
fairly short order.

Posted by coffeetime on June 2, 2010, running KDE4.
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Configuring
Configuring and
and Using
Using Epson
Epson Stylus
Stylus NX415
NX415
by Patrick G. Horneker

Second, replacing the HP57 color cartridge is not
really cost effective. In the past, I had used generic
equivalents, but the last time I used a generic color
cartridge in the PSC2175, the printer rejected the
cartridge. Replacing the cartridge with a Hewlett
Packard cartridge solved that problem, but created
another problem. It cost me $39.99 every time I had
to replace the cartridge, and hence the device was
no longer cost effective to operate.

Editor's Note: Exercise EXTREME caution when
following the instructions in this article. This article's author
advocates installing packages from outside the official
PCLinuxOS repository. Should you follow them, you will
then have a nonstandard installation of PCLinuxOS, and
may not be able to get any assistance for any problems
you may encounter in the PCLinuxOS forum, since
unknown changes will have been made to your system.
Please remember that the best way to get the packages
you need is to make a request in the Package Request
section of the forum for those packages to be added to the
official PCLinuxOS repository.

With Epson cartridges running at an average of
$15.00 per cartridge per color, this saves me some
money every time I need to change one cartridge.
Even with the worstcase scanario (all four
cartridges need replacing), I still save a little money
over the HP equivalent (which would be about
$63.00 if both cartridges needed replacing).

Introduction
Recently, I had some color issues with my aging
HewlettPackard PSC2175. It served its purpose
over the past eight years I had the machine. It
printed with amazing speed, and color copies printed
correctly. When it came to scanning and printing
photographs, the device was starting to show its
age. Color photographs were biased towards the red
side on photographs taken indoors, even with my
digital cameras. When I used xsane to scan the
white area on the scanner lid, the auto adjustments
for gamma, contrast and brightness to get a true
white were an indication that the scanner had an
issue. There were inaccurate colors in the resulting
scans when I compared what was on the screen to
the original photographs.
This meant one of two things. I either needed to get
a stand alone scanner, or an allinone device.
Shopping around online at Best Buy, Office Depot,
OfficeMax, Staples, Meijer and WalMart lead me to
one conclusion: An allinone device was actually
cheaper to purchase than a stand alone scanner.

This is not to say that HP printers are not good. In
fact, they are excellent printers. The issue I have
there is with the cost of operation.

At the time of this writing, Office Depot and Best Buy
had the Epson Stylus NX415 on sale for $49.99
USD, which is 50% off the original retail price.
Two other things led me to purchase this allinone
device.
First, according to books on digital photography I
have read, Epson printers are the best at printing
photographs.

Of course, Epson does not specify cartridge yields
for their ink cartridges. This is in part because a little
ink is used every time you power up the printer. This
is necessary to ensure quality of the output and to
keep the ink from clogging the nozzles on the
cartridges.
Preparing Your PCLinuxOS Machine
Unlike HewlettPackard printers and allinone
devices, the newest Epson allinone devices require
download of additional software, or at least updating
what you have on your PCLinuxOS installation.
Epson allinone devices only require the latest Sane
and the latest Gutenprint drivers to function. The bad
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news is that neither the epkowa backend nor the
iscan functionality as supplied with PCLinuxOS
supports any of the NX series allinone devices
(through the sanebackendsiscan package). The
good news is that the latest Gutenprint drivers do
support the NX415 and other NX series allinone
devices.
The first thing to do is to download the latest iscan
package from the Avasys website. You will be asked
to agree to their licensing agreement. Then you will
be asked about your working environment and your
distribution. For PCLinuxOS 2010, you will need to
specify “PCLinuxOS” as your distribution, then
“Other” as the version. After answering the
questions, you will then be taken to the page from
where you can download the needed RPM
packages.
For PCLinuxOS 2010, you only need to download
the iscan2.24.04.i386.rpm package. This provides
the scanner drivers for local use. If you wish to use
this for network scanning, you will also need to
download the iscannetworknt1.1.02.i386.rpm
package.
Now that you have the needed RPM packages,
presumably in your Downloads directory (if you used
Firefox to visit the Avasys website), you will need to
install the RPM packages.
Notes on the Printer Drivers
Although the Gutenprint drivers do the job well for
this printer, you may also want to download and
install the pipslite1.4.05.i386.rpm package for the
Avasys developed driver as well as the Epson

Stylus_NX415pipsliteen.ppd file for installation
with CUPS.
PIPS stands for Photo Image Printing System and
was designed specifically for printing of photographs
to Epson printers.
Special Instructions for Installation
PCLinuxOS comes with the iscansanebackends
iscan package already installed if you are using the
full XFCE, LXDE, KDE or GNOME versions.
If you do not have SANE installed on your
PCLinuxOS installation, you will need to open
Synaptic and under Tasks, select tasksscanning to
install the required packages to install SANE.
The iscan package you have just downloaded will
conflict with the sanebackends and sane
backendsiscan because of the epkowa driver in
the packages. This is OK as we will be replacing the
iscan functionality of the epkowa driver with a
newer version of the epkowa driver as well as
installing the iscan graphical utility not present in the
sanebackendsiscan package (due to licensing
restrictions).
As of this writing, the current iscan package is
named iscan2.24.04.i386.rpm.
To install this package, login to a terminal window as
root (using the su command), and then type in the
following:
rpm i –replacefiles iscan2.24.04.i386.rpm

This will install the necessary SANE drivers that are
compatible with the NX415 and several other Epson
allinone devices (such as the WorkForce 310 and
the Stylus NX515, which is similar to the NX415,
but includes wireless printing through a WiFi
connection).
Note: If Synaptic updates any of the sane
packages, you will need to reinstall the iscan
package to ensure the NX415 allinone device
will continue to work. You can do this by issuing
rpm U –replacefiles iscan2.24.04.i386.rpm as
root.
Once you have succeeded, you now have the
Avasys iscan utility available to scan images, and
that utility will appear in the Graphics menu, as well
as an entry under File → Create → Scanning (iscan)
within the latest version of GIMP.
Now, We Setup the Hardware
Once we have the software installed, we will need to
setup the hardware.
The NX415 comes with four ink cartridges (Epson
69), a power cord, a CDROM, a Quick Setup Guide
poster, and a user's guide. Epson does not supply a
USB cable with this printer, so you will need to be
sure you have a spare USB 2.0 cable available.
(Actually, this is a trend among all the major printer
manufacturers to not include a USB cable with the
inexpensive models, not just Epson and Hewlett
Packard.)
On the Quick Setup poster, you will only need to
follow the instructions shown until you get to the
Install CDROM part. You will not need the CD
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ROM as we have already installed the necessary
software to get the NX415 to work under
PCLinuxOS.
Once you have the NX415 setup according to the
Quick Setup instructions, you may then plugin the
USB cable.
Next, We Setup the Print Queue
Now that we have iscan and the Gutenprint drivers
installed, we are now ready to setup the print queue.

one devices, and they do an excellent job when it
comes to printing.
Click on Next to create the print queue. You will
then get an opportunity to set default options for the
NX415. Click on Set Default Options to finish the
setup.
Close the web browser to exit the CUPS Web
interface. We are now ready to use the NX415.

Printerdrake currently does not detect the NX
415, and hence we are not able to setup the print
queue this way. Instead, we need to setup the print
queue using the CUPS web interface, i.e. open a
web browser to http://localhost:631/. Then select
the Administration Tab, click on Add Printer, then
select NX410 (the CDROM that came with the NX
415 confirms that the NX415 is a part of the NX410
series). When prompted, you will need to type root
for the user name, and the root password for the
password. (This is the password you use to login as
the system administrator.)
Then, select Next of which the next screen will
display a suggested name for the print queue,
specifically EPSON_epson_stylus_nx415. You can
change this to whatever you want, such as
StylusNX415. However, there must be some name
in this field as it is the only required field for this
screen. Click on Next to get to the next screen.
Here, you select an appropriate printer driver for
CUPS to use. I suggest selecting NX415 using the
CUPS + Gutenprint 5.2.5 driver. The latest
Gutenprint drivers support the newest Epson allin

epkowa driver to the latest versions not supported
by the sanebackends and sanebackendsiscan
packages.
As a bonus, we get the Image Scan! graphical utility
designed specifically for Epson's scanners and all
inone devices.
IMO, Image Scan! does a much better job of
scanning than xsane. As you can see in this
screenshot, Image Scan! has an Auto Exposure
button that automatically adjusts
the scan so you get great
photograph scans every time.
Click on the Adjust tab, and you will
see options not found in the xsane
utility.
Also, as shown in this screenshot,
Image Scan! works as a GIMP
plugin as well as a stand alone
utility.

The Iscan Utility
The NX415 will work with scanning utilities that use
the SANE interface. When we installed the iscan
package, we upgraded the SANE interface to
support Epson's newest allinone devices. More
specifically we upgraded the iscan utilities and

Of course, xsane has an auto
adjustment feature, but Image
Scan! makes color and brightness
adjustment much easier so you can
concentrate on your photograph,
and not on configuring the scanning
software. This is useful if you have
a lot of photographs you need to scan.
By default, ImageScan is set to scan at 300dpi on
the NX415. You can scan up to 2400dpi on the NX
415, NX515, WorkForce 310 and several other
models. The NX110 and NX115 can scan up to
1200dpi. Of course the latter are lower end models
of the NX series.
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Controls on the NX415
The NX415 has a number of features that you can
use even without your PCLinuxOS machine
powered on. Here you can copy documents, print
photo proof sheets, print photographs from memory
cards, and check ink levels of the cartridges.

Screenshot
Screenshot Showcase
Showcase

There is a 2.5 inch LCD
screen for display of
information and images off
the memory card.
The photo proof sheets you
can print from here can be
used to select photographs
off the memory card to print.
You can select images by
making a checkmark in pencil
in the circle area below each
thumbnail. The proof sheet is
then scanned, and the
resulting photographs are
printed. The process is
similar to the forms used for
taking SAT tests in high
schools.
The Setup button pulls up a
menu that allows you to see
the ink levels of the four
cartridges without having to
use the mtink utility. (This is
a great feature as the mtink
utility does not support this
printer.)

Posted by BPsoftware, June 15, 2010, running Phoenix.

63

KarlM:
KarlM: The
The Loss
Loss Of
Of A
A Friend,
Friend, Supporter
Supporter
KarlM, a PCLinuxOS community
member, supporter and friend
passed away on June 23, 2010.
News of his passing was from his
friend, Jeddaboy, and read as
follows:
My name is Wayne, AKA: Jeddaboy. I
am so very sad to have to notify all
members of the passing of a long time
member, strong supporter, loving and ever ready to help
out any one where possible, KarlM. Unfortunately, I am
in shock at the passing of my friend. We met on the forums
years ago trying to sort out Skype issues. It developed into
a very close, loving mate ship. He developed and through
Ondisk, distributed his DVD Repository Collections to
help those less fortunate, because of finance and being
stuck on dial up connection. Please remember him and if
any of you are the prayerful type, pray for his family and
friends now in mourning.
Jeddaboy continued a little later on:
He was an extremely intelligent man, a whiz at math,
physics, university educated. He was approximately 70, I
think. We spent hundreds of hours on Skype, talking
computers, all manner of things. We laughed and cried
together at times. He was a quite achiever, with all his
intelligence he was one of the most humble, kind hearted
men i have ever met!
KarlM first joined the PCLinuxOS forum in January
21, 2006, and made his last visit to the forum on
June 14, 2010. In that time period, KarlM offered his
assistance and insights on 420 topics in the
PCLinuxOS forum.

“And in the end, it's not the years in your life
that count. It's the life in your years.”
Abraham Lincoln

KarlM’s last forum post was to fellow community
member tame, regarding printing on CDs with an
Epson inkjet printer. Yet, one of his last forum posts
reads as follows, and serves as good advice to all
who visit the forum. From May 28, 2010, it is as
follows:
Do not say dumb!
Smart. You posted your problem. You provided exact
information (the picture) of what you did and what
happened. Thus someone else could see where the
problem was and suggest a possible solution.

When you think emotionally charged words like "dumb"
or "bad" to yourself, the human mind then forgets the
details around that incident. Details you may need in the
future. What you did today that produces a result you did
not want, is likely to be the same thing that in the future
you need to do to get a different kind of result that you
then want.
I have made the same (spelling error) kind of mistake a
number of times. It is very hard for me to see, and it took
me a lot of time to finally see the missing, or extra letters.
The Cut and Paste of what one did and not words about
what you think you did and what you think happened, is
advice that has been repeated many other times on this
Forum.
I want to compliment you on providing information (the

picture) on exactly what you did and exactly the results
you achieved. This is smart and not "dumb".
Rest in peace, KarlM. You will be missed. And the
entire PCLinuxOS community offers their heartfelt
condolences to his friends and family during this sad
time.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
PCLinuxOS Magazine Forum:
http://pclosmag.com/forum/index.php
Main PCLinuxOS Forum:
http://www.pclinuxos.com/forum/index.php?board=34.0
MyPCLinuxOS Forum:
http://mypclinuxos.com/forum/index.php?board=157.0
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More
More Screenshot
Screenshot Showcase
Showcase
Top Left: Posted by
Hootiegibbon, June 27,
2010, running KDE 4.
Bottom Left: Posted by
ongoto, June 04, 2010,
running Gnome.
Top Right: Posted by
menotu, June 12, 2010,
running KDE 4.
Bottom Right: Posted by
Neal, June 25, 2010,
running PCLXDE.

65

